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mMacOS
OoNnoMma

For Beginners

mMacOS Sonoma For Beginners is the first and only
choice if you are a new Apple Mac or MacBook adopter
and want to learn everything you'll need to get started
with Apple’s operating system. This independent guide
Is crammed with helpful guides and step-by-step fully
illustrated tutorials, written in plain easy to follow
English. Over the pages of this publication you will
clearly learn everything you need to know about your
Mac and apps by first understanding the macOS that
powers them. With this unofficial instruction manual at
your side no problem will be unsolvable, no question
unanswered as you learn, explore and enhance your
MacOS Sonoma user experience.
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“"We show you your Mac's basic features, such as

the Desktop, menu system and trackpad gestures,

moving on to detailed guides to its key apps..."

Can You Run
macOS Sonoma?

Older Macs cannot be updated to the new
operating system, so if you want to
upgrade your Mac to macOS Sonoma, it
must be one of the following models:

=

—m O A A B

Mac Studio, 2022 and later
iIMac from 2019 and later

MacBook Pro, 2018 and later
MacBook Air, 2018 and later
Mac Pro, 2019 and later

Mac Mini, 2018 and later

iMac Pro, 2017
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First Steps
with macOS

Sonoma

Here we get to grips with the basics of
macOS, such as setting it up out of the
box, using Gesture Controls, the Finder,
getting online and more. The new
macOS Sonoma wallpapers and
screensavers are covered, as are the
Desktop Widgets that let you check
Important information straight from
your Desktop. Look out too for guides
to Spotlight, Notifications, the Dock,
Sonoma’'s menus and more.




-irst Steps with macOS Sonoma

A

Set Up Your Mac
' For the First IIme

If you have a new Mac but have not yet set it up, follow this guide. It's
nothing to be afraid of; follow the guide and the on-screen instructions, and
step by step, you get to set your Mac's language, take it onto the Internet
with your Wi-Fi network, sign in with your all-important Apple ID and more.

& @

Language Select Your Country or Region

English

Francais

United Kingdam
AMohanistan

@ terms of the software licence agreement for the software, You can view the
: licence agreement at https:/fwoanw apple. comfuk/iegalisla/

Now you must choose your territory, that is, where you
live and will be using your Mac. You can scroll the list of

First, you might see this window, inviting you to choose
the language you use to set up your Mac. The most

popular languages are at the top of the list, but if you want to countries up and down to find your own, or start to type it to
use an alternative one, scroll up until you find it, click on it and get there quicker. Click your country to highlight your choice,
then click the arrow (bottom right). then click Continue.

&

Written and Spoken Languages

®

Accessibility
Tha follewning Isngusges sre COMMonly USed I YOUF Megion. You can se ¢ sl
up your Mac (o use thesa settings of customisa tham indnsdually

3 Now select your Mac's language and input source. The f you have a disability that makes it harder to use a

default ones for your chosen territory are offered, but if computer, the Mac's Accessibility tools could be of
you want to change them, click Customise Settings and set interest. If you want to set up your Accessibility settings now,
the language your Mac uses and the keyboard layout to best click one of the buttons. If not, click Not Now —you can do it
Suit your needs. later in Settings.

8 | www.pclpublications.com



i,

Data & Privacy

This icon appears when an Apple feature asks (0 use your personal
information.

You won't see this with ewery leature since Apple collects this information
only when neaded to anable featuras, sacure our safvices or parsonalise
POLE SXpEriEncs

Apple believes privacy is a fundamental human nghl, 50 every Apple
product is designed to minimise the collectson and use of your data, use

on-davice processing whanever possible, and provide transparency and
control over your information

2arn hore

Next comes the Data & Privacy screen. You're shown an
icon that appears when an Apple feature collects
information, and needs your permission. There's nothing you
need to do on this screen, just read it for reference and move
on once more.

. "

Sign In with Your Apple ID
Sign in 1o use iCloud, the App Store and other Apple services
.I .
Lreata new Apple 1D

Fargotl Appla 1D or password?

Cloud and Appée media purchasos?

7 Now it's time to sign in with your Apple ID. If you already

have an Apple ID, sign in now with your password. If you
don't, click the Create New Apple ID link and follow the
on-screen instructions. There's also a link for if you've
forgotten your Apple ID.

Create a Computer Account

Fill put the followng information 1o creale yOur COMDUler acCount

Your account name is based on your Apple ID name but
your password, which unlocks the computer, should be
chosen now. Choose something you can remember and enter
a hint in case you forget. Click the small picture to choose a
different one, or take a photo using the Mac's camera.

' Set Up Your Mac .

&)

Migration Assistant

if you hawve (nfarmation on another kMac or & Windows = ol you Can ira nsfer it to thes Mac. You can also
transfer information fram a Time Machine backup or another startup disk,

How do you want 1o transfer your information?

) From a Mac, Time Machine backup or Startup disk

From a Windows PG

You're invited to transfer information from a Mac or Time
Machine backup, a Windows PC or not at all. To transfer
data from your old computer, choose the correct option and
follow the on screen instructions. Otherwise, choose the last
option to start afresh.

Terms and Conditions

important: Use of your Mac computer, the macOS software and related services is subject 1o these
Terms and Condilians. Pleass resd them carafully,

A. macOS Software Licence Agresment

You're shown a screen of Terms and Conditions, which
you can read by scrolling if you wish. When you're ready,
click the checkbox labelled ‘| have read and agreed to the
ICloud terms and conditions’, then click the Agree button in the
bottom-right corner of the window.

You can also change your avatar now, if you wish. Simply
click on the one you have at the moment — the image in
the circle to the right of your full name and account name —
and you're given the chance to change it to a Memoji, Emoiji,
monogram, a photo and more.

www.pclpublications.com | 9
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A

4

Enable Location Services

Analytics

Help Apple and app developers improve their products and services automatically

Location Services allows apps like Maps and senvices like Spotlight
Suggestions 1o gather and use data inchuding your approximate location

) Share Mac Analytics with Apple

Enable Location Services on this Mac
Help Appks impeovs Is products and serastes by
ally sending dugnostics and usage dala

agniosisc data may nclude location nformation
Aboul Locabon Services
=hare crash and usage data with app developers

Hiélg app dévalopirs 'Mprove Their 3pore by Bllowing
SRS R e . TR

About Analytics & Privacy

Now you decide whether to Enable Location Services or
not. It's up to you, but there's a lot of Mac features that

You can now choose whether you allow analytic
information to be sent to Apple and/or third-party

depend on being able to tell where you are to work, for software developers so they can improve their products. If
example, finding your location in Maps. Click the box if you you're concerned about privacy, you can decline, but it's helpful
want to enable it, and then click Continue. If you agree to share.

Screen Time

C

Siri

Sirt helps you get things done just by asking. Siri can also make suggestions before you ask in apps
sSearch and Eeyboards,

ot Insights about your Screen Lime and set [imits for what you want 1o
manage.

Z Weekly Reports

Downtime and App Limits
gl | ; - Enable Ask Siri

® Conmtent & Privacy Restrictions
auiret i { | y i

:: Screen Time Passcode
'. AL i JiJE i 1 i i

13 You now decide whether or not you want to set up t's time to set up Siri, and decide whether or not you

Screen Time. Click Continue to have Screen Time give want Apple's own digital personal assistant to activate
you updates on how you're using your Mac, or the Set Up Later  when you say, Hey Siri." Click the checkbox in the middle of the
ink at the top to leave it be for now. You can activate it later in window if you wish to do so, then click Continue and follow the
macOS Sonoma's System Settings. on-screen instructions.

Hilp Apple improve Sin and Dictaton by allowing Apple 1o store audis of your Sin and Dictation
interactions from this Mac. Apple may review a sample of stored audio. You can change this Iater in
System Settings

Q Improve Siri & Dictation

._a ] Thes data is ot assoialed with your Appda 1D and will only ba storad Tor a imited panod
Select a Sir1 Voice

Share Audic Recordings

Mot Mow

You can now choose a Siri Voice, that is, the voice used
by the Siri digital assistant when you use this feature on

Do you wish to send information to Apple for it to use in
improving the Siri and Dictation features? These

your Mac. Click on each voice in turn to hear what it sounds recordings are shared with privacy in mind, and Apple never
like, and then click the one you want and click Continue. You Knows who sent which recording. Click Share Audio
can change it in Settings later if you wish. Recordings or Not Now.

10 | www.pclpublications.com



Set Up Your Mac |68

" gk Findewr Film Fdit View Go Window Haip QO E © Wed8Mov 07:26 O

Choose Your Look

I a see how the Dock, menus, buttons and windows adjust depending on which
ore you choose

You can change this later in System Settings.

BOe=S0vg @80 70820 ¥

Choose how your Mac will look when in use. You can Your Mac soon boots into macOS Sonoma, the latest

17 go for the default light look, with white as the version of the Mac's operating system. If you open
predominant background colour, or dark, with black System Settings (from the Apple menu, Dock or Applications
backgrounds. Auto switches between light and dark folder), you can change its appearance and wallpaper, should
depending on the ambient light. you not like it as it is.

Reset to Factory Conditions

If you acquired your Mac second hand, you might want to wipe it clean and start again. Just follow this guide.

Instail m acOS 13 beta Erase “GIGABYTE OP-GSTFS312400NTD Media™?
he (N sllached dal > ' ' Frasng "CHIARYTE GP-GESTFEH 240GNTD Media® will permansntly
e o dats viored om . You cam™ wndo e sCEsom
MName

Safari b

Disk Utility
et . = 1 l.

\q- [ 3 4

First, restart your Mac whilst holding down cmd-Shift-Alt-R (Intel  From the window, select Disk Utility (the bottom of the four
Mac) or by pressing and holding the power button (Apple Silicon  options) and click Continue. Select your startup disk (called
Mac). The Mac continues to boot, but instead of the regular Macintosh HD by default) and in the toolbar at the top of the
desktop, a window appears showing four options as seen here. Disk Utilities window, click the Erase icon to wipe it clean.

mac0S$S14

ontinue installing the software, you must agree to the terms of the software license agreameant.

APPLE INC.
SOFTWARE LICEMSE AGREEMENT FOR APPLE CONFIDENTIAL macOS PRE-
RELEASE SEED SOFTWARE

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT ("LICENSE" ) CAREFULLY
BEFORE USING THE SOFTWARE. BY USING THE SOFTWARE, YOU ARE
AGREEING TO BE BOUND BY THE TERMS OF THIS LICEMSE. IF YOU ARE

TO BE BOUND BY THE TERMS OF THIS LICENSE BY CLICKING THE “"AGREE"

A copry of the Licands will b aaved oh your system and can b hourd through
ALl Thid MEd 107 FAitilal=omn. 1 &8 #dd posled a1 MBI vwwe B pdle © o eGElTa

Dinnlﬂﬁom_:

On the next screen, the Format pull-down menu should read Now choose to install macOS and continue. When invited to install
APFS if it's available or Mac OS Extended (Journaled) if it isn't. the operating system, do so; you might have to click on the Wi-Fi
Select the appropriate option and click Erase to wipe your boot icon in the menu bar and rejoin your wireless network. Agree to

drive. When it's finished, click Done, then quit Disk Utility (cmd-Q).  T&Cs, select your main drive and click Install to start afresh.

www.pclpublications.com | 11



ﬂ First Steps with macOS Sonoma

7\ Using TouchID
(’@D\’ On Your Mac

If your Mac supports it, you can unlock your computer using your fingerprint
Instead of entering a password. Just place your finger on the fingerprint
sensor and it springs into life. You can also use Touch ID to unlock your Mac,
Input passwords and make purchases, all by using your fingerprint.

Setting Up Touch ID

f @ SystemSettings File Edt View Window Help

Light D Beito

P Mok L

Highlight colousr B Accent Colowr £
Sidebar icon sire Medwum S
Allow wollpaper tinting in windows .

Show scroll b ars
O Automatically based on mouse o trackpad

1 First of all, open the System Settings window. Click on
ouch ID & Password. If this option isn't there, your Mac
doesn't have the Touch ID feature.

Q, Search Password
- A login password has been set for this user, Change...
(2] General
A arance
@ PR _ Touch ID

\

Place Your Finger

Lift and rest your finger on Touch 1D repeatedly.

npﬂ'i rde

Internet Accounts @ lan's Apple Watch )

3 Type your admin password when asked, the one you use

to unlock your Mac. As instructed, you must now place
the finger you intend to register on the Touch ID sensor, on the
top-right of the keyboard.

12 | www.pclpublications.com

¢ Touch ID & Password
Password

A login password has been set for this user.

B siri & Spotiight
u Privacy & Security
a Desktop & Dock

Displays
n Use Touch ID for Apple Pay

Use Touch ID for purchases in iTunes S
and Apple Books

Use Touch ID for autofiling passwords

Use Touch ID for fast user switching

Apple Watch

JEE ADEYR Watch o unlack your app ATignE amd r
O lan's Apple Watch

) walet & Apple Pay

{: Keyboard

To get started, click on the + icon captioned ‘Add
Fingerprint. You can add more than one print to Touch ID
if you wish, but here, this is our first.

& < > Touch ID & Password

Q& Soorch Password

A login password has been set for this user. Change...

Touch ID

Place Your Finger

Keep going to capture the edges of your fingerprint.

Use Appie Watch to unlock your applications and your Mac.

Q lans Apple Watch

internet Accounts

w Game Center

Keep raising and lifting your finger. As you can see, the
grey fingerprint in the window gradually turns red, as
Touch ID reads, analyses and records your fingerprint. Keep
doing this until the centre section is full.




Q Search Password

- A login password has been set for this user. Change...
\2) General

4PpeRcAIce Touch ID

Place Your Finger
Keep going to capture the edges of your fingerprint.

Cancel

Internet Accounts @ lan's Apple Watch

Touch ID now needs to cover the edges of your finger.
Continue lifting and placing your finger, but concentrate on
having the edges of that fingerprint on the Touch ID sensor.

- )
Q, Search Password
- A login password has been set for this user. Change...

Touch ID -

Touch ID is Ready

Your fingerprint can be used to unlock your Mac.

Jse Apple Watch to unlock vour applications and vour Mac

Internet Accounts © lan's Apple Watch ('.

¥ Game Center

The edges gradually go red. Eventually, all the fingerprint
area is red, and the registration is complete. Click the
Done button in the bottom-right corner.

L I { » TouchID & Password

Q. Search Password

T A login password has been set for this user. Change...
ie) General

Sppsarce Touch ID

Touch ID lets you use your hingerprint to unlock your Mac and make purchases with
Apple Pay, iTunes Store, App Store and Apple Books.

Accessibility
L=J Control Centre
© siri & Spotiight :’:rﬁ“))\ {'F@x +

u Privacy & Security Finger 1 Finger 2 Add Fingerprint

B Desktop & Dock
E3 pisplays
e Wallpaper

Use Touch ID to unlock your Mac
Use Touch ID for Apple Pay

Use Touch ID for purchases in iTunes Store, App Store

i =t Savr and Apple Books

n Battery
Use Touch ID for autofilling passwords

n Lock Screen

«
«
€«
«©
O

Use Touch ID for fast user switching

Touch ID & Password

E Users & Groups
Apple Watch

Use Apple Watch to unlock your applications and your Mac.

B Passwords

Internet Accounts Q lan's Apple Watch

7 There's a list of things you can do with your Touch |ID
instead of typing your admin password. Take a look and
uncheck any that you don't wish to use.

Purchases & Passwords

Wednesday, 25 October

2113

Unlocking Your Mac

With Touch ID, you can place your finger on the sensor to
unlock your Mac, without your admin password. You still
need the password after it restarts.

m—F
=
) siri & Spotiight N ﬁ‘t

) privacy & Security
Passwords Are Locked

Touch ID or @nter the password for the user
*lan Osborma™ 1o undock,

l |

Purchases and Log-Ins

You can use your Touch ID to make App Store purchases
and enter login details. Instead of typing a password to
complete the purchase or log in, use Touch ID.

Amar Yapp lan Osborne

Login Window...

Users & Groups Settings...

Fast User Switching

If two people have accounts on your Mac, and you've
enabled Fast User Switching from the menu bar, you can
use your Touch ID to switch between users too.

www.pclpublications.com | 13
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-irst Steps with macOS Sonoma

) Welcome to the
Sonoma Desktop

The desktop is at the heart of your Mac. Everything you do takes place on
the desktop, including opening apps, interacting with files and folders and
using the Dock. Here we show you how to use your desktop, app and folder
windows, the top bar menu, Bin and more.

From the Apple menu you can
log out, shut down, restart or
put the computer into sleep mode,
get comprehensive information on
the computer's hardware and
software, access the System
Settings and open items you've
recently closed.

The menu bar running along
the top of the desktop gives
access to functions and controls for
the app you currently have open at
the time. The app currently in use Is
shown to the right of the Apple icon.
In this case it's Finder. Open or click
on an app and its name is shown
here instead; and its menus are listed
iNn the menu bar.

B he Control Centre is where
you can access Bluetooth,
Wi-Fi settings, display brightness,
volume, Stage Manager, Screen
Mirroring and much more.

Application windows come in
all shapes, sizes and designs.
Your Mac's applications can be
launched from the Launchpad, the
Dock, from Spotlight or using
Applications window in Finder.

This is a Finder Window. The
Finder utility is the central
point for navigation and file
manipulation. You can browse and
navigate applications, documents,
external drives and even access
other computers; as long as they're
connected to the same network
(cabled or wireless).

14 | www.pclpublications.com

This is your Mac's Desktop.
Click on it to hide all open
windows, showing your Desktop
Widgets, if you've added them. You
can change the picture (or
wallpaper) used for the Desktop in
System Settings > Wallpaper. The
one we have here is the standard
macOS 14: Sonoma desktop, but
there are plenty of awesome
pictures to choose from.

In macOS, folders work just like
their real-world counterparts.
You can use them to store files, data
and even other folders. You can call
them anything you like; click on a
folder's name and type in a new one

The Dock offers quick and
easy access to your favourite
applications, documents, folders
and even the Bin. It's easily edited
and customised to make the most
of the way you work. Apps you
currently have open are always
shown in the Dock.

You can also put folders in the
Dock, as shown here. Click on
a folder to open it within the dock,
and then click on something inside
the folder to open or launch it.

m The Bin, formerly called the
Trash. To delete a file, folder or
application, drag it into here, then
right-click on it and choose 'Empty
Bin' from the menu.

( Finder File Edit View Go Window Help

About This Mac

System Settings...
App Store

Recent Items
Force Quit Finder

Sleep
Restart...

Shut Down...

Log Out lan Osborne...

2




fThe Sonoma Desktop

Siri
Siri is Apple’s
personal digital

Date, Time,
Notifications &

assistant and you L Wi d g ets

Get to know Siri at Apple.com.

can use peh L Al Click on the time here and to open
Mac. Just click on © sin

this icon and a Siri Siri's here to help ﬂ.]e amConanS and WidQEtS
Window Opens. See gﬁés:nr:rr:‘inden get the weather, make a FaceTime call, Slde.bar. If YOU QO |nt0 SYStem
Hhs S Bukirial for ek 1o Ko S o8 Apylmcomryek | S.ettlngs > Control (?entre and
more information | click the Clock Options button..

G Boarbe 166 you can set how the date and time

this feature. are displayed here.
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B First Steps with macOS Sonoma

A

creen Savers
and Wallpapers

Screen savers have come a long way since the flying toasters. Now you
can have all sorts of graphics and images activate when your computer
goes to sleep, and even integrate your screen saver with your Desktop's
wallpaper. Here's how to use this great new Sonoma feature.

Choosing a Screen Saver

@8 SystemSettings File Edt View Window Help

Q1 Search Options...

& wi-Fi

B Bluetooth

B siri & Spotiight
[ privacy & Security

(&) Desitop & Dock

ﬂ Displiys

et Wallpaper

F !.-,“.-
i !
: I
B
mﬂaitew

n Lock Screen

1 Open System Settings from the Apple menu in the There's some great slow-mo aerial shots on offer, divided

top-left of the screen. In the left-hand sidebar, click on iINnto categories; Landscape, Cityscape, Underwater, Earth.
Screen Saver. A range of savers is on offer, including currentand ~ The Shuffle Aerials option lets you use a screen saver chosen at
past macOS savers, aerial photos and various graphics. random from one of these categories.

—

4 > Screen Saver

. Scotland Castle

Q, Searc J Scotland Castle OO
>3 Wi-Fi Show as wallpaper

= Show as wallpaper
B Bluetooth Show on all Spaces

Show on all Spaces
Network
s 0 e 0 L N s

9 Notifications Sonoma Ventura Monterey
LU Sound

Landscape Show All (61)

» Pl -
Y :
] £7 ()
‘felg +

lceland Lake + scotland Castle Yosemite Valley + scotianc Coast +

< Landscape Show All (61

&3 screen Time ' . 5 . %
% — -
\z) General - 3
“leld 4

m Appearance lceland Lake 4 Scotland Castle Yosemite Valley 4 Scotland Coast 4

Accessibility
Cityscape Show All (30)
L Control Centre

7/ I. I1'=. F" —_—
J ¥ 1,\

) siri & Spotlight BN: N

u Privacy & Security . . :

Dubai Skyline + Los Angeles Flyover 4 London Evening New York Night 4

Cityscape Show All (30)

j .'. + I"
i 1._ n
Y X 4
= |
i - !
i

Dubail Skyline + Los Angeles Flyower + London Evening New York Might +

8o

G V'S Underwater Show All (21)

B Desktop & Dock

Scroll left and right along a row to see more screen When it's downloaded, you can preview the screen saver
savers, or click Show All for all the options in a category. by moving the pointer to the thumbnail and clicking on

When choosing an aerial screen saver, it has to download; see Preview. The screen saver is shown. Press a key, move the

the progress circle in the top-right corner of the window. mouse or touch the trackpad to stop the preview.
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® @ < Screen Saver

Scotland Castle

Show as wallpaper

Show on all Spaces

TRl T L W e NN

G Notifications Soncma Veniurn Monterey

m Sound

Edaiia Landscape

B Screen Time
w General

hmea‘[ﬂnte fcelard Lake + scotland Castha Yosemite Valley +
Accessibility

Lj Control Centre
B siri & Spotiight
n Privacy & Security

Spcotland Coast +

Cityscape Show All (30

Dubal Skyline 4 Los Angeles Flyover = ardon i Hew York Might +

B peskiop & Dock

| Customising the Sonoma

Wallpaper

Automatic o
Show 8% SONe0n Saver

Show on all Spaces

Network

dudd Photo «  Add Folder or Album «
ﬂ MNotifscations

(R sound

Focus Dynamic Wallpapers

Screen Time

|z General

a Appearance
Accessibility

L) Control Centre
B sici & spotsght
D Privacy & Security

& peskiop & Dock

Desktop

Choosing a Wallpaper

E3 Displays Underwater Rl Disolays
.-, Wallpaper m
i | Screen Saver
bt o Battery
e Battery

Alpakan Joliyfish California California r.h| Const + n Lock Screen

Light & Dolphin Pod + Kelp Forest 4

B Lock Screen

Turn on Show as Wallpaper and a still from the slow-mo In System Settings, click Wallpaper in the left-hand column.
screen saver is used as your desktop image. Show on Al These options let you set the wallpaper independently of
Spaces makes it so for all your desktops. Leave this off and you the screen saver. The aerial photo wallpapers are there,

can have different wallpapers for each desktop. along with some from older versions of macOS.

P =,

Show on all Spaces

Add Photo »  Add Folder of Album w

Undervwatler

ﬂ!- "=

Appearance Al um ..In
Accessibility

{7J Control Centre

) siri & spotiight

3 Frivacy & Security

"!lnnhnFrm

Earth

B oesktop & Dock

3 oisplays Shutfle Aerials

W wallpaper .
o) Screen Saver
:} Battery

Srulfle A0 Lareiuca pe BFeilfle CHySCH

n Lock Screen

i, -

When waking your Mac from sleep, login information is now There are options to Show as Screen Saver and Show on All
at the foot of the screen, out of the way of the beautiful aerial Spaces atop the window too. You can also Add Photo or
video. When you unlock your Mac, the slow-mo video tums into the Add Photo or Album using the pull-downs if you want to use

desktop, if you're using it as a wallpaper too. a picture on your Mac as wallpaper.

Scroen Saver

" Mg
f Show as wallpapar

Show on all Spaces

Shutfe AN W Lared siabe ShaufMa Cltyscabe ShulPg Lindesiwaler 4

Accessibsbity Tt
4 Control Centre

) sii & spotiight

U Privacy & Security

B oesktop & Dock
Displays

el WE'IID.EpEI'

) Screen Saver

E Battery

u Lock Scrsan

7 At the foot of the Screen Saver options is a category Some wallpapers have a Light and Dark mode, set using
called 'Other’. These give access to options you might the pulldown at the top of the Wallpaper options.

have used on older versions of macOS. You can also use one of ‘Automatic’ changes between light and dark according to

your own photos as a screen saver here. the time. You can also use a solid colour as a wallpaper.
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-irst Steps with macOS Sonoma

ol Bl BB 35 Bl B4 B BF

==ﬁ;='-= Gesture Controls
'w On Your Trackpad

You can navigate your Mac using gesture controls, just like you do on

your iIPhone or iIPad. These gesture controls can be performed on a Mac
notebook’s trackpad or on the Apple Magic Trackpad, which is available for
desktop Macs. You can even do a few of them on a Magic Mouse.

One of the things that makes the Mac such a pleasure to use is its large and responsive MacBook multi-touch
trackpad or the desktop Mac's Magic Trackpad. You can use the trackpad in much the same way as you would use
the touchscreen of an iPhone or iPad: to quickly and easily access menus, sort through stacks of pictures or
documents, scroll through documents and to zoom in and out of displayed images. Once you get used to it, you'll
find that it's a very easy and intuitive way of controlling your Mac and that it can do far more than just scrolling.

. g | B8R0 B088Es
Secondary Clicking. LTI I T TIT-ITTT
Some people like to use a two-button ='I-Illﬂﬂﬂ-.....=

mouse with their Mac, and this can be handy ...._-.-.-

for quick access to shortcut menus by
| secondary clicking or right-clicking. To set up
/ two-finger secondary clicking using the
: trackpad, select Secondary Click in the Point
& Click pane of Trackpad preferences. To set
up a one finger secondary click zone in the
bottom left or right corner of the trackpad or
mouse, select Secondary Click in the Point &

Click pane of Trackpad preferences, and choose Smgle Click
an option from the pop-up menu. Unlike most other trackpads, the entire MacBook trackpad

works the same as the mouse button; and you can click
anywhere on the track pad to activate apps and select icons.

Multi-touch Gestures.

The MacBook's advanced trackpad and Apple's Magic
Trackpad support Multi-touch gestures. They might seem
a bit complicated at first but once you get used to them,
they quickly become second nature. Before long you'll
wonder how you ever managed without them. The trick to
using the trackpad properly is to practise using more than
one finger at once. Some gestures use two fingers, whilst
others use three or even four. You need to apply light, firm
pressure and move your fingers smoothly and evenly, all at
the same time. Like we said, it takes a little practice but you
quickly become proficient at it. To enable Multi-touch
gestures, view instructional videos of the gestures and set
up various other trackpad options, choose Apple > System
Settings and then click Trackpad in the left-hand sidebar.
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Scroll Vertically

Place two fingers together on the trackpad, then move them up
or down. This will scroll vertically up or down the document or
web page you're currently viewing.




Zoom In and Out

Two-finger pinching lets you zoom in or out on PDFs, images,
photos, and other large visual documents or web pages. Place
two fingers on the trackpad, then move them apart to zoom in,
or together to zoom out. The quicker you move your fingers,
the more you'll zoom.
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Access Mission Control

You can access the macOS Mission Control at any time, even if
you've got a full-screen app open. SImply place three fingers at
the bottom of the trackpad and move them quickly upwards and
Mission Control appears.
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Force Click

The very latest Apple notebooks feature Force Touch
trackpads, which can tell a soft tap from a hard tap. A hard
tap, or Force Click, can be used to preview a file, drop a pin
in Maps, preview a Safari link, rename a file or folder and
more. It's a concept that should prove very familiar to
those who have used the latest iPhone models.

| ‘[ |

Gesture Controls
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Rotating Images

You can rotate images by placing two fingers on the trackpad
and then turning your hand so that your fingers both move in a
curve. It can be a little awkward on the wrist at first but you'll
soon get used to it. It's a very handy gesture if you're laying out a
page in a desktop publishing app.

|
i3 o 7 iJ

_-I-H-l-n-

Switching Between Full-screen Apps

f you've got several apps open full screen at once, you can
quickly flip between them using a gesture. Place three fingers on
the trackpad and quickly slide them to the left or right. This will
scoot the current app aside, revealing the next in line.

B Users & Groups

W Game Center

E Wallet & Apple Pay Look up & data detectors

L ey DoATd Sacondary click

Maus i
L VOUSE Tap to click

L) CD= & D\VDs

uprf EEEEE & Scanners

—

&' NTFS for Mac

Turn Off Force Click

If you dislike the Force Click gesture, and find it gets in the
way of your workflow, it's easy to turn it off. Open System
Settings (under the Apple menu in the top left corner), and
click Trackpad in the left sidebar. Look for the option
'Force Click and haptic feedback'. There's a switch to its
right; use it to turn the Force Click option on and off.
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B -irst Steps with macOS Sonoma

Desktop Widgets
New In Sonoma

If you click on the Mac's time in the top-right corner of the screen, you get
a sidebar showing notifications and Widgets. You knew that, right? But did
you know that with macOS 14: Sonoma, you can also place Widgets on the
desktop? They're unobtrusive, easy to use and packed with information.

Widgets on the Desktop

£l [ e
b e e ndan 8
| 1 [ | L bl
TTERTE S S AT SR

A raaly ! X =
q B ! '|I r._.'-‘uj‘.“ (= : .,
,#ﬁ#mﬂ:ﬁﬁ&wmﬁhr%Fﬂ uring

Diag a widget to place i on the deskiop or in Motification Centre...

1 Right-click on your Mac's desktop for a contextual menu.

From this menu, choose the Edit Widgets option. A
Widgets picker appears. In the sidebar is a list of apps that offer
Widgets, with the Widgets themselves on the right.

3 Drag Widgets out of the picker and onto your Desktop.

either click the minus sign in its top-left corner on the picker
screen, or right-click on it and select Remove Widget.
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You can place them wherever you like. To delete a Widget,

Wiiew EPali BT (A Ml Tip'e Cithes B 0uwnd Whiew e Time o el Tg0e O R Eund
el e, kFem @k,

| Drag a widget 1o plsce it an the desktop or in Notification Centre._. m

Scroll up and down the right-hand section on the picker to
explore available Widgets. Click on an app in the left to
see what Widgets it has to offer. Sometimes, Widgets of
different sizes are available. Scroll to see them all.

By ' o ? n
: *) g 10.9-inch
. ¥ g

Finder File Edit View
|

{(10th generation)
- Technical

You can edit a Widget by right-clicking on it and selecting
Edit “[Widget Name]". What editing options are there
depends on the Widget in question. If multiple sizes are
available, you can change its size from this menu too.




MacBook Air 15"

Impressively big. Impossibly thin.

From $108.25/mo. lor 12 mo. or $1299**

————

If you're doing something else on your Mac, Widgets
become monochrome and fade into the background.
Click on the Desktop to hide open windows and turn your
Widgets coloured again. Click a Widget to open its parent app.

Shiow recE=l sy i Flaps Warages

Shemy wifuliyerd [Poem i e B0t

WaLogaTy

Sl Wit 8 oo Deslng [0 In Blege Mamager

To keep them coloured or monochrome at all times, go to
System Settings > Desktop & Dock and in the Widgets
section, use the Widget Style pull-down to select Monochrome or
Full-colour. They then stay that way at all times.

< »  Desktop & Dock

Stage Manager
HlEge Manager &TaNges your

Show recent apps in Slage Manager

Show windows from an application

Widgets
Show Widgels @ On Desktop In Stage Managers
Widget style Automatic £

Use iPhone widgets O

Default web browser @ Safari

Windows
\2) General
m Appearance
Accessbiily Ask to keep changes when closing documents

Prefer tabs when opening documents

Eﬂ Control Centre Close windows when quitting an application
Whan erabled, open documsents and windows will not be restored when you
B sivi & spotiight

) Frivacy & Security

7 Also in the Widgets section of the Desktop & Dock

settings, you can choose whether to use Widgets from
your iPhone on your Mac's Desktop, and whether they appear
on the Desktop, in Stage Manager or both.

| Desktop Widgets — New in Sonoma

Widgets in the Sidebar

=
=
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The Widgets sidebar used in previous versions of macOS

Is still there, and still displays Widgets of your choice. To
open it, click on the time in the right-hand side of your
Mac's top bar. The Widgets sidebar springs into place.

# 2 9 ryBECaNnNoES LD 2 &2 @m ¢t * ¢ q

Copg & wedjert 10 placd & oo B deskiog or o WoEdwalion Costra

Scroll this sidebar all the way up and at the bottom you see
a button marked ‘Edit Widgets'. Click on this and the Widget
picker appears once more. From here, you can drag and
drop Widgets into the sidebar to customise it.

Click on the minus sign in the top-left corner of a Widget to
remove it from the sidebar. When you've finished, click the
Desktop or click the Done button at the foot of the Widget
picker. Your customised sidebar is then ready for use.
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B -irst Steps with macOS Sonoma

fg Dark Mode
- . And Night Shift

If your screen’s too bright, there's a couple of great desktop features that
help. Dark Mode inverts the Mac's colour scheme, making it much darker,
and Night Shift Mode changes the colour hue, reducing blue light that can
keep you awake if you use your Mac before going to bed.

Dark Mode Night Shift Mode

e0000O® SO0

In windows

0 Automatically based on mouse or trackpad

B Deskiop & Dock
&) Displays

1 From the Apple menu, open System Settings. In the From the Apple menu, open System Preferences. Click on

left-hand column, click on the Appearance option. At the Displays in the left sidebar and then on the Night Shift
top of the right-hand section are the Light, Dark, and Auto button. From here you can schedule Night Shift Mode to run
buttons. Dark and Light buttons switch to those modes, and from sunrise to sunset or during custom times; or you can simply
Auto sets it according to your Night Shift schedule. turn it on by checking the Manual box.

Choose a Template

Mecesnts

s AL P e :
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Automatically adjust b §
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With Dark Mode on, the colours are subdued or With Night Shift Mode enabled, the colour spectrum
reversed in Finder, windows, the Mac's built-in apps and shifts from blue to yellow. If you use your Mac late at
more. Third-party apps can be built to take advantage of Dark  night, too much blue light can interfere with sleep patterns, so
Mode too. If you find it more comfortable to work on a darker using Night Shift Mode when on your Mac close to bedtime
screen, this is excellent news. can prevent this from happening.
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If your Mac's desktop regularly gets cluttered with folders, file icons and
other such material that you're currently working on, there's a solution at
hand in macOS. With a click of your mouse or trackpad, you can organise
them into stacks, grouped according to their file type. Here's how to do it.

1 Your Mac's desktop often fills with files and folders you
know you need regularly but that can mean a very
cluttered workspace. To use Desktop Stacks, first click on the
desktop to make sure Finder is active, then click on the View

menu in the top bar.

is

.y

3 To open a stack on your desktop, click onit. The items

contained in that stack are revealed, allowing you to
access and open individual files. To close a stack again, click
on the down-pointing triangle icon that replaced the stack
when you clicked to open it.

From the View menu, select the Use Stacks option. Your
files are stacked on the right-hand side of your desktop,
according to their type. For example, images are stacked
together, as are documents. To turn this off again go to View
and click Use Stacks.

@ Finder File Edit View Go Window Help

as lcons

as List

as Columns
as Gallery

v Use Stacks
R e None

caaa ln v Kind ~R2
Clean Up By

i Date LastOpened "7+ =

Hide Tab Bar Date Added A% 4

Show All Tabs

You can choose how you group your stacks. In View, go
to Group Stacks By and then pick an option. If you use
finder tags (see later in this book) to identify files from the
same project, for example, grouping by Tags keeps them
together and easier to find.
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B First Steps with macOS Sonoma

Getting Online
X With Wi-Fi or Ethernet

As Is the case with any modern computer, access to the Internet is a vital
component for upgrading and getting hold of new apps that will help you
get the most from your Mac. Getting online in Sonoma is remarkably easy
and here's how to do it both wirelessly and with a cabled connection.

Connecting with Wi-Fi

menu bar. You'll see a list of Wi-Fi networks. If your Wi-Fi is off
click the switch to turn it on.

The Wi-Fi network “VM7677700" requires a
WPA2 password.

You can also access this Wi-Fi network by sharing the
password from a nearby iPhone, iPad or Mac that has
connected to this network and has you in their contacts.

Show password

Enter the password here. If you're setting up at home, the
password is probably supplied with your router. Your Mac then

joins the network, and remembers it so you don't have to add the

password every time you go online,

24 | www.pclpublications.com

1 Make sure that your Mac is within range of your wireless
router's Wi-Fi signal, then click on the Wi-Fi icon in the top

3 If a password is required (it probably is), a window appears.

Click the Other Networks chevron and see a list of Wi-Fi
networks available in your area. A lock to the right shows

a password is required. Click on the network you wish to join,
whether it's your own router or a public Wi-Fi in a cafe or bar.

Using Public
Wi-Fi
Some high street locations
such as libraries, bars and
restaurants offer free Wi-Fi
to their customers. There
are many different ways
you can access public
Wi-Fi. Some locations may
have an unsecured
connection, some require
you to ask for their Wi-Fi
password, and for others you have to register via their
pop-up website; just open Safari while in such a Wi-Fi

zone and then follow the on-screen instructions that
appear when your Mac connects to the network.
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1 Click on the Wi-Fi icon in the top bar, and in the menu that

IS shown, click Wi-Fi Settings at the bottom. The System
Settings window appears, with Wi-Fi already open. Scroll up and
click on the Advanced button.

WPA3 Personal
WPA3 Personal
WPA3 Personal
WPAZ Personal

QOO QCOODOD

You can see a list of all the Wi-Fi networks your Mac has
connected to, in order of preference. Where two
networks are available, the higher one is used. If you want to
change this order, simply drag and drop them.

Click Detalls next to your current network and then the
TCP/IP button. You can see what IP address your Wi-Fi
router has allocated to your Mac. Advanced users can then edit
these settings and create your own, static |IP address.

3

| Getting Online _

Going Online with Ethernet

If you prefer the stability and speed offered by a
cabled, Ethernet connection, here's how to set this up.

7 B

Once you've set up your router according to the instructions
supplied with the device, getting online using Ethernetis
relatively easy. First of all, you need a cable that looks like
this. There should be at least one supplied with your router.

- B

e R

. il

S

Plug one end of the cable into your Mac and the other end
into one of the router’'s Ethernet ports: it doesn't matter which
one. If your Mac doesn't have an Ethernet port, you need an
adapter. You can get one online or from an Apple Store.

If your router isn't close
enough to your Mac to :
support a cabled [
connection, consider
using Home Plug AV
instead. This uses your ,
household electrical [
wiring to send data. i
Ask at your local r
computer store about a
Home Plug AV starter
kit. There are many
different brands of <A
HomePlug AV devices
to choose from, and as
HomePlug AV is an
industry standard,
they're all compatible
with each other.
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B -irst Steps with macOS Sonoma

Sonoma’'s Menus
A Key Mac Feature

Whether it's a pull-down menu accessed by clicking on the top bar of your
desktop or a contextual menu found by right-clicking or ctrl-clicking on a
file or folder, you need to know how to use your menus if you are to get the
most out of your Mac and Sonoma. Here's a guide to your Mac's menus.

The Apple Menu

The Apple menu is Choose About This Mac 2 The System Settings Hover your pointer over

always found in the for a window showing option opens the Mac’s the Recent ltems option
top-left corner of Sonoma’s you technical information about System Settings, which we o see the sub-menu showing
desktop. To open it, click on your computer. Clicking More discuss later in this book. apps, documents and servers
the Apple icon once, then Info... lets you delve further, you've recently used. You can
choose an option. This looking at its Display, Storage This option opens the click on one of these items
menu is always there, and more; and you can get a App Store. If updates and open it, offering a
whatever it is that you're full System Report by clicking are available for your Mac or convenient way of accessing
doing on your Mac. the System Report button too. any of its apps. things you recently closed.

1 m Finder File Edit Go Window Help
About This Mac 2

System Settings...
App Store 4

. Recent Items | Applications

6 © Show “Baldur's Gate - Enhanced Edition” in Finder
w Show "FaceTime” in Finder

N Show "News" in Finder
Show “Notes"” in Finder
| = Show “Preview" in Finder

Show “QuickTime Player” in Finder
@ Show “Safari” in Finder

Force Quit Finder

| L o i
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3
e Lt b SR T '\-'.'::- '..'.'-:'_. ! '-'-—__1-; l.-\.h-': '-I!"-.'- . 1:.;'."".;‘-:""_—;'-:"-_-"—' e L | e e -J-.l-.-'l_.' e Rt e
o Show "Kojak - SO3EQ5 (Be Carefu You For )
- Lk > L i A e

- Show “Screen Saver Step 4 guide” in Finder

- Show "Screen Saver Step 5 guide” in Finder

- Show "Screenshot 2023-10-23 at 12.46.12 pm" in Finder
- Show "Wallpaper Step 2 guide” in Finder

- Show “Wallpaper Step 3 guide” in Finder

| [7) Google Drive
[Z] lan Osborne
[ 1an ian.osborne@dsl.pipex.com
2 Personal
1 4 [ Public
| [ SmartWare

[£) Team BDM
El TimeMachineBackup
£ Work

Clear Menu
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B Click here for the Force
Quit window. This
window lists all currently open
applications and notes if any
of them are unresponsive,
that is, they've crashed. You

can force a crashed app to
quit from here.

7 Click here to put your
Mac into Sleep Mode.
This saves energy and
password-protects your Mac
while you're away from your
keyboard for any time.

Open

Click here to restart
your Mac. This is useful
f you've installed new
software or your Mac isn't
behaving as it should.

Click to shut down your
Mac, that is, switch it off.

Lock screen brings up
your password screen.
You have to enter your

password to continue to use

your Mac. It's useful if you're
leaving your Mac for a while.

Mova to Bin

Get info

Rename

Compress "Accounts”
Duplicate

Make Alias

Quick Look

Click here to log
yourself out but not
shut down your Mac. This is
useful if you have more than
one user account on your
Mac. You can then log out so
another user can log in.

By hovering over the

Recent ltems option,
you get this sub-menu. This is
a list of the applications
you've recently used. Click on
one of them to open it again
rather than use the Dock.

& Photos File Edit Image View Window Help

MNew Album
New Smart Aloum...
MNew Folder

cait Smart Album

Import...
Export

Share...

Create

Play Slideshow

Show in All Photos

Show Referanced File in Finder

:Sonoma’s Menus

These are the
documents you've
recently used. If you need to
open one again, this menu is a
quick and easy way to do so.

Servers you've recently

accessed on your
wireless or Ethernet network
appear here. To open one
again, simply click on it.

Click here to completely
clear the entire Recent
ltems sub-menu.

Consalidate..

Copy Close

Share...
Burn to Disc...

- 9000
Tags...

import from iPhone oriPad >
Quick Actions b

Services »

Contextual Menu

Files and folders have a Contextual Menu that you can access
by right-clicking or ctrl-clicking on the item, or clicking with two
fingers on a trackpad. This menu gives a range of options, which
change according to what it was you clicked on. There's usually
a Share and a Move to Bin option in there, and the Get Info
option brings up an information window.

Application Menus

Each application has its own unigue set of menus located next
to the Apple menu. They will change when an application is
active and will revert back to the Finder menu when no apps
are active. Each is clearly labelled to make it easier. We'll add
specific details for application menus when we look into the
applications themselves later.

Right-clicking and ctri-clicking.

Mac mice and trackpads only have one button, so how do you make a right-click? It's actually easier than you think.

Point & Click Scroll & Zoom More Gestures

|-, Screen Saver

Ene Saver
g ENeTY Tracking speed

n Lock Screen
W Touch ID & Password Click

E Users & Groups

Silent clicking
Wy Passwords

iarnat ASeo s Force Click and haptic feedback . @
<HCK thar

N prass fhemily Tor Quick Look, Look up and vanable spaed

% Game Center

Wallet & Apple Pay Look up & data detectors e e i i R

Off

+ Click with Two Fingers

Click in Bottom-Right Corner

\d Keyboard
U Mouse

Secondary click

Tap to click

Click in Bottom-Left Corner
Tap with omne fingo

Tap with Threa Fingars 5

L CDs & DVDs

Chek with Two Fingers 2

() Printers & Sc Set Up Bluetooth Trackpad... ?
rinters anners

() cos & DvDs

{_j Praniters & Scanneiy

&3 NTFS for Mac

M WNTFS 1 =

1 Your Magic Mouse or Trackpad doesn't have two buttons,
but you can still secondary-click by holding the Control
(ctrl) key and clicking your mouse or trackpad. Alternatively,
enable right-clicking. Go to Apple menu > System Settings >
Mouse/Trackpad, depending on which you're using.

Use the pull-down to choose an option for Secondary
Click. With Secondary Click activated, clicking using
your chosen option is the equivalent of right-clicking on a
two button mouse. You can change the tracking speed and
click strength here too, and more.
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. Using Finder
Hles, Folders & Apps

Finder is the main app that underpins everything you do in macOS, so

it's worth taking the time to discover its features and functions. On these
pages you'll see how Finder works and how you can use the Finder window;
Including its navigation controls, viewing tabs and many more useful options.

Window Control Options: Use the gumdrops to
close or minimise the window or open it in full-screen
mode. We'll cover this on the next page.

Navigation Controls: The chevron buttons in the
top left corner of the window take you forwards or
pbackwards through your navigation history.

View Options: These four buttons let you set-up
how you view the files and folders in the Finder window;
whether as icons, a list, in columns or as a cover flow which
gives you a much larger visual preview.
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Iltem Arrangement List: Click on the button shown
here to order the contents of the window; according to
date, alphabetically and more.

Share Button: The Share button is found in many
places throughout macOS. Here you can highlight a file or
folder and click the button to send it by email, AirDrop and
Messages, add it to Notes and more.

Tags Button: You can tag a file or folder to make it
easier to spot or group it with other documents and
folders. An item can have more than one tag. Click on a tag in
the sidebar to show items labelled with that particular tag.
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7 Perform Tasks: The Perform Tasks icon enables you
fo perform certain tasks within the folder or highlighted file,
such as create a New Folder, Move to Bin, Duplicate and more.

Search Field: If you're looking for a specific item, type
its name or contents into the Search field and press Enter.

Sidebar: There are various options on the Finder
window’s sidebar. You can open specific folders like
Documents or Downloads, access external or network drives
and more. To hide and show the sidebar, use the View menu
or enter ctrl-cmd-S.

Displaying a Finder Window

There are several ways of opening a new Finder window
on your Mac's desktop. Let's take a look at each In turn.

@ Finder File Edit View Go Window Help

New Finder Window 3E N |

New Folder HHEN
New Folder with Selection NHEN

New Smart Folder

Using Menus

Click a clear space on the desktop once, open the File menu
and select New Finder Window. A window then appears.

Shortcut Keys

Click a clear space on the desktop once to make sure you're
in Finder, then press cmd-N together. A new Finder window
appears on the desktop.

Using the Dock

f it isn't already displayed, move your mouse cursor to the
bottom of the screen to open the Dock. Click the Finder Window
to create a new window.

Window Controls Options.

The coloured buttons, or gumdrops, are found in the top left

corner. Hover over them and a symbol appears in each of them.

Close

of windows and applications.

Minimise

all windows and apps.

Full Screen

Click the green button with two
triangles. This will full-screen most
Finder and app windows.

Click once on the red button containing
a cross. This will work with the majority

Click the orange button containing a '-’
sign. Again this will work with almost

File/Folder View: This shows the files and folders

contained in the currently open folder. They're shown

in the format chosen in the View Options (see ltem 3). Here,
as you can see, we've gone for the icon view.

Preview: This is a preview of the currently selected file
In the main window. It shows the title, file size and various
details about it. There are also options at the foot of the
Preview sidebar, such as rotating or marking up a graphic or
creating a PDF from a document. The preview sidebar is
optional; you can close it in the View menu or by pressing
Shift-cmd-P on your keyboard.

How to Relaunch Finder

If the Finder has crashed or isn't behaving as it should,
follow this tip to close it like a crashed app and relaunch it.

- Finder File Edit View Go Window Help

About This Mac

System Settings...

App Store

Recent Items >

\ Force Quit Finder oD I

Sleep

|
m | IR A ek <L A 9
- locK SCcfreen. S L

If the Finder crashes, you can relaunch it like you would with any
other crashed app. The easiest way to do this is to click on the
desktop to make sure you're in Finder, hold down the Shift key
and click on the Apple menu. The Force Quit option has
become Force Quit Finder. Incidentally, you can use this method
to quit any running app. Just click on one of its windows to bring
it to the fore, hold Shift and click on the Apple menu.

Navigation Controls.

These simple controls allow you to retrace your steps
backwards and forwards through Finder.

S \viateto:
Previous Page
Click the left hand arrow. To
continue stepping backwards,
repeat step one as many times

as necessary.

The Forward Control

If you've moved to a previous
page, this button offers
step-by-step navigation to your
original starting point. Simply
click the right-hand arrow as
many times as needed.

> Ap
<@A
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A

View Options

Finder File Edi ‘View Go Widow Halp

¢ > Applications
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View Window Contents as Gallery View

The Gallery View gives a large preview of the file or folder that's
currently selected and a scrollable strip of everything else. Click on
one of the files in the strip to see a larger version of its thumbnail.

View Window Contents as Icons

o display your files and folders as a collection of icons, first
open a Finder window then click the first button on the toolbar,

showing a group of four squares. - .
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As well as changing the way the items are displayed, you

; . ) can also change the way they are arranged.
View Window Contents as Lists

With an open Finder window, click the second button on the
toolbar to use a simple but effective list display.

Name: Alphabetical. Displays numbers first, then A-Z.

Kind: This groups each type of item together.

Findar File Edit View Go Window Help

Application: Groups together items according to the
application in which they were created or are opened.

s Date Last Opened: Groups according to time and
.o date they were opened.

@ Osgital Colour Meter
& Desic Unility
[ Feodback Assistant

Date Added: Displays items in order of when they
ety o were added to the folder.

Date Modified: Displays items in the order they were
last modified or edited.

Date Created: Displays the items according to when
they were created.

View Window Contents as Columns

Size: Arrange the files according to their size.
Click the third button on the toolbar to view your files as a series
of columns. It's great for quick navigation and easy visual
identification using a handy image preview column.

Tags: Files are arranged according to tags you've added.
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More Sidebar Functions

If your sidebar is getting cluttered, you can show or hide its
listed items by hovering over the title (Favourites, Locations,
ICloud, Tags) and clicking the small down-facing chevron or
right-facing chevron - the right-facing chevron appears when
the title is hidden, and the down-facing chevron when they're
expended. You can also eject external drives, CDs and disk
images from the sidebar; by clicking the ejecticon next to the
device or image you wish to remove.

® o Recents = & 2
Favountes Name Kind
iCloud & Using Finder, View { PNG ima
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1 Highlight an item within your Finder window, and click on the
three-dots-in-a-circle icon for a drop-down menu. Here you

can do a range of operations, from opening a highlighted file in a

specific application to checking the file size via the Get Info option.

Finder windows have a right-hand sidebar that shows a
preview of the currently selected file from the window. You
can turn this sidebar on or off in the View menu (Hide/Show
Preview) or press Shift-CMD-P on the keyboard.

Perform Tasks Within the Finder
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You can also clean up the entire Finder Window,
automatically tidying up and or reorganising the order of
the files according to various criteria such as their name
(alphabetically), date, size and more.

u} ® ©
[ Create PDF
@ Convert Image

Rotate Left Markup

Remove Background

Customise...

At the foot of the preview sidebar are a set of new options.
These vary according to the type of file you're previewing in
the main window. For example, an image can be rotated,
annotated or converted into a PDF.
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A

Full-screen Mode

If you want to view the Finder window better or any other window for that matter, then you can always opt to view it in
full-screen mode. Full-screen removes distractions and makes everything a little easier to read. Here's how it works.

®@=-0 { Millie

M Enter Full Screen
@] Tile Window to Left of Screen
(W Tile Window to Right of Screen

Sy

D Move to SMB2230H
= [C] Move to lan Osborne’s iPad Pro

iCloud
& iCloud Drive

C=iy i i T .

You can view a Finder window and indeed an application
window, in full-screen mode. Click on the green gumdrop
in the upper left cormer of the window and fills the entire screen.
Alternatively, use the View pull-down menu or press ctrl-cmd-F.
Hovering over the gumdrop gives this menu.

@ Finder File Edit View Go Window Help

X y 4 Millie
@ @) ExitXull Screen

b.

o

15
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(=] Desktop

IMG_0309..

— Essential Appl@

3 The Apple Watch “-:;.b
§ ' Creative Cloud Files

3 To exit from full-screen mode back to the usual window

view, bring up the Menu bar and then simply click on the
green button again. The window shrinks to its previous size and
no longer takes up the entire desktop.

32-Bit Apps No Longer Run

llllllllllll

b A

In full-screen mode, the menus usually found at the top of
the Mac desktop are still there but they're hidden away
until you need them. To see them, move the mouse cursor to

the top of the screen and the menu bar slides into view and

disappears when the cursor is moved away.
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] Storage Drive 3
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a— CloudMountar - Farsonal Do,

a2 CloudMounter - Work Dropbox
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You can also take a window out of full screen mode using
the View pull-down menu at the top of the screen or by
pressing ctrl-cmd-F. You can still close a full-screen window with
the red button (top left).

Apple has phased out support for applications built for 32-bit architecture. These will no longer run in macOS.

Chess CleanMyMac X CloudMounter Contacts devolo
&
- 7 N\ AA -
FaceTime Flow Font Book GoodLinks
e | [ =
i .. ”
- - 1 1
iMovie Kaspersky Keynote Launchpad Mactracker
g Internet Security "

In Monterey and Ventura, you can no longer open applications
made for older 32-bit processors (modern processors are 64-bit).
If you have such an app on your Mac, it appears in the Applications
window, or Launchpad, with a crossed-out icon atop it.

32 | www.pclpublications.com

— g L — — — T I e—

1 Utilities T Contacts

“"Flow"” needs to be updated.

The developer of this app needs to
update it to work with this version of A A I
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Try to open a 32-bit app and you get a message saying it's
not compatible with this version of macOS. Check with its
developer whether the app has since been updated to 64-bit,
but if it hasn't by now, it might well have been abandoned.




Changing the Finder Window's
Background Colour or Image

1 When you're using the Finder's Icon View, you can replace

the white background with a coloured one or even a
picture. To begin, with the Finder window in question open, select
Show View Options from the View menu or press cmd-J.

The window's Info window opens. Towards the bottom, you
can see options listed under the header '‘Background'. Select
Colour’ and click on the white square. You can now use the various
options to change the background colour.

3 Select 'Picture’ and then drag an image into the box to the
right of the background options to get a pictorial
background. Alternatively, click on the box and then navigate to
the picture you want to use through the Finder.

| Using the Finder E-

Accessing iCloud Drive

ICloud Drive can store and share files across Mac or i0S
devices logged into the same iCloud account.
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Click on iCloud Drive in the Finder window's sidebar. You
see the iCloud Drive folder is organised according to apps.
You can create your own folders here too.

@eow [L] ZPersonal
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& iCloud Drive
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™ Browso W, S
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Files and folders found here are synced using iCloud Drive,
so they're available online at www.icloud.com and also on
other devices linked to the same iCloud account.
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Files
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Here we've opened the Pages I0S app on an iPad. As you
can see, the documents in the Mac's Pages iCloud Drive
folder are also available to open and edit here.
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Sonoma’'s Dock
‘< For Most-used Apps

The macOS Dock is a feature that greatly speeds your workflow. It's
perfect for gaining quick access to the most relevant and frequently used
applications, documents and folders. It's customisable too, which means
you'll come to personalise your Dock to best fit your own unigue needs.

Accessing Your Applications from the Dock

Add or Remove an Application Move an Application

To add an app, first click the icon filled with multicoloured boxes To move an item to a new location in the Dock, click and drag
on the left-hand side of the Dock to bring up Launchpad. Then, to the required position. As you move the item the adjacent
click and drag the item you want onto the Dock. To remove t, applications will move aside to allow you to drop the icon into
just drag it out. its intended place.
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Open an Application Currently Open Apps

O open an application that's in your Dock, simply move the Applications that are currently open on your Mac but don't
mouse pointer onto the Dock and click on its icon. Notice usually live in the Dock are shown in their own section in the
that the app icon slightly bounces as the application opens right-hand side of the Dock. You can click on their icons to
before the main app opens. bring them to the fore.
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Sonoma’s Dock

The Bin

The Binicon is located at the far right of the Dock and
can be filled and emptied just like a real rubbish bin.

‘ ’

- H0@e0 ~wmiise 9

Adding and Removing Stacks

You can add, remove and move folders in your Dock, in the
same way you do with apps. These sit to the right of the
Dock's second divider and are called Stacks.

You can delete a file, folder or app by dragging it into the
Bin on the right-hand side of the Dock. Alternatively,
right-click or Ctrl-click on it and select Move to Bin from
the contextual menu that appears.

Terminal VaiceOver Utility Open in Finder

Accessing Stacks To retrieve a file from Bin, click on the Bin icon in the Dock to
open it in Finder, then drag the file out of the Bin window. To
empty Bin, right-click on it and choose '‘Empty Bin', or in the
Bin window, click on the Empty button (top right).

To access the files and folders within a Stack, click on it to
display the contents. Clicking on a document or image opens
it with an appropriate application and clicking on a folder
opens it in Finder.

Customising the Dock

You can customise your Dock in System Settings from the
Apple menu and selecting Desktop & Dock. From here, you
can place the Dock on the right, left or bottom of the
screen, opt to show and hide it, change its size, change its
magnification, choose a minimisation effect and more.

Minimise windows nto applicatian icen

Automatcally hide and show the Dock

Show mdicators for opon applications

Show suggested and recent apps in Dock

Viewing Options @ o N

Show items + On Desktop in Stage Manager

Right-click or ctrl-click on a Stack for a pop-up menu with a O sy asecn B sy T
range of options. You can show your files as a Stack (a pile of — |

files) or as a folder. You can also choose how they're displayed
when you click the Stack.

Stage Manager
SLAge Mandds arfandel pihe relent Wi
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® Notifications
- See What's Going On

Apps and functions on your Mac can send you notifications, which let you
know what's going on. When you receive a message or an email, for example,
you can be notified that it's arrived. You can customise them too.

@ Finder File Edit View Go Window Help —I

_ Louise Treloar
‘. Twelve South DeskPad

If you came to

Sonoma from a T b T‘w?t:ﬂmb“ g
pre-Big Sur version of -
macQOs, you might
look for the
Notification Centre
icon In the top-right
corner of the screen.
However, It's not
there. Instead, Apple
has integrated
Notifications into the
Date/Time and
Widgets zone.
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Rain for the
next hour

FRIDAY
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¥

oving natifications to the Date and Time and combining them
with widgets is a clever move on the part of Apple. All you
need to do to view your notifications is to click on the Date and Time
N the top-right of the desktop. If there are any, they appear at the top
of the slide-in area that appears from the right-side of the screen.
Notifications are grouped together depending on the app
they're coming from. For example, the News app displays
notifications based on what news channels you've decided can
send alerts to you. If you click on a notification in the group, the
rest expand so you can see all the available notifications of that
group. And clicking on a notification, whether it's from Messages,
News and so on, opens up the corresponding app.
This makes viewing notifications a much more efficient

from gen Z to 80-plus

CNN
v Mike Johnson, key figure in efforts to
LN overturn the 2020 election, elec

House speaker

Read Story

#News Top Stories 2 days ago
Tories braced for another by-election with
MP Peter Bone facing six-week suspension
over bullying report

process, since there's a minimal need for mouse clicks, and Hover over a notification for an expansion chevron in the

it's easy to see which notification belongs to which app. If upper-right corner. Click it and the notification expands to display
you're on the lookout for an important news flash report, for more information. In addition, by moving the mouse pointer over
example, you can quickly get the information you need when it  the notification bubble you'll also see an ‘X' in the opposite top
appears on your screen. corner, for dismissing the notification.
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Creating and Removing Notifications

System Settings File Edit View Window Help

»  Notifications

{

Notification Centre
Motification Contre shows your notificatong in the top-right cormar g
fou can ahow and hede Mot |caban Cantre By clicking the clack i tr

Show previews When

Allow notifications when the display is sleeping

Allow notifications when the screen is locked

Network - ‘
m on Allow notifications when mirroring or sharing the display
Application Notifications
? Amphetamine
off
= Apolio
o
@ General
App Store
a !ppm # Badges, Alerts, Time Sansitive
Accessibility
- balenaEtcher
B Control Centre ot
B siri & spotiight
_w BetterZip
) erivacy & Security ' oft
Desktop & Dock Books
D Earners

1 Adding and removing app notifications is as simple as
navigating to System Settings > Notifications. It's the ‘Bell’
icon in the left-hand sidebar of the System Settings window.

In the Notifications panel on the right, there's a few options at
the top followed by a long list of the applications you have
installed on your Mac. Scroll through the list and find the app for
which you want to set the notifications. Click the app in question.

Canary Mail

Q. Search

. Apple ID
YO ramiy ae ([___os

|
Bluetooth None
Network

VPN

‘ Allow notifications
- Canary Mail

Banners

stay on screen until dismissed.

Show notifications on Lock Screen

Show in Notification Centre

Badge application icon
E Screen Time

General

@ Appearance
Accessibility
Control Centre
& siri & Spotlight
u Privacy & Security

Play sound for notification

Show previews

Notification grouping

Desktop & Dock

ﬂ Displays
. Wallpaper

@ Screen Saver

3 Within the Notifications window, you can set a number of

options for how you want to review any Notifications from
the app you've activated. For example, the Alert Style can be
adjusted to None, Banners (the default, and the one that most
folk will use), and Alerts. You can also opt to display Notifications
on the lock screen — although this is considered a security risk if
you leave your Mac unattended. There's also options to play a
sound when a Notification comes in and you can set the
Notification Grouping to Automatic, By App or Off.

Boot Drive Backup
The backup completed successfully,
Copled: 14.82 GB - Tima: Bm 25s

Banners appear in the upper-right corner and go away automatically. Alerts

L N < Canary Mail
Q Search & Allow notifications D
~ Canary Mail
B o0
G@ Family
—d Wi-Fi
a Bluetooth None Banners Alerts
Network Banners appear in the upper-right corner and go away automatically. Alerts
stay on screen until dismissed.
. VPN
Show notifications on Lock Screen [ @)
Show in Notification Centre [ @
g Focus Badge application icon [ @
Screen Time
B Play sound for notification [ @
-] General
. Show previews Always
Appearance
i3] Accessibilit otification grouping utomatic £
y Notificati - A —

a Control Centre
B siri & spotlight

ﬂ Privacy & Security

a Desktop & Dock

n Displays

When you've found the app you want to set the
Notification for, click on the ‘Allow Notifications' slider
outton to activate and deactivate notifications from that
particular application.

= Fri270ct 12 29pm

BBC News 1006 am
., Thousands of banned dogs are being
N\ allowed to live at home with their owners

under strict rules, data released to BBC

Q&

Yesterday, 708 pm

The Indepandent Yestorday, 6:34 pm
N Tory MP arrestad on suspicion of rape and
~ possassion of drugs

Notification Centre

dNews Spotlight: Prope... vesterday, 17am
- "We moved 10 times in 18 months after our
N home flooded" + Is now a good time to
from gen Z to 80-plus

CNN 2 days ago
Mike Johnson, key figure in efforts to
overturn the 2020 election, elected US
House speaker

Default

dNews Top Stories 2 days 8go
%+ Tories braced for another by-election with
LN MP Peter Bone facing six-week suspension

When Unlocked
Never

-

As you continue to use your Mac, the number of
Notifications you'll generate over the course of a week or
even a day increases. Open the Notifications window, and click
the oval button marked "X more Notifications' to show all the
notifications currently available. The chevron next to the words,
Notification Centre’ closes them again.
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ﬂ First Steps with macOS Sonoma

TheSpotlight Feature
Search Your Mac

Spotlight Search is Apple's unique and ultra-powerful search system that
can find almost anything on your Mac. There's a raft of great features,
making it a really powerful and useful tool, and you can even use it to
launch applications. Here's how to use the Mac's Spotlight feature.

Usmg Spotllght S Features

1 Press cmd-space bar or click the magnifying glass in the
top menu to open Spotlight. You can drag this window to

Spotlight can do conversions. To convert from imperial to
metric (or vice versa) type in the number and a type of unit,

wherever you want on the screen. Type your search query into such as kilograms or pounds and then click the chevron next to
Spotlight and answers appear, with suggestions based on the the top result. Spotlight offers other commonly used units. It
contents of your computer as well as other sources. works in a similar way with distances and lengths.

Q Germany

@ Germany national fosthall team — Foctbal fear

Q. germany flag
'@ germany time

|4 63.KB - Datafork Truetype® Faot - Modified 5/08/2013, 6:65 am

].: ’a sl g#!l
4‘ —§ J_ = Hg

3 0 do currency conversions at current market value, just For more conventional searches, Spotlight pulls its

type in the amount you want to convert followed by ‘in information from a wide range of sources, such as
[new currency]. Here, we typed '£300 in €, but '£300 in euros’ or  Wikipedia and documents it finds on your Mac. Double-click on a
‘300 pounds in euros’ works just as well. result to open a document or glean more information.
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' The Spotlight Feature

o 1N

L°P=. | 5

o T e P i I M
i ; Do 5 .
iy .I'l:--
] P T
-

. Thicw-away Accounts for work — . .
m*mmmﬁnw“m

T e e

If you're looking for local businesses or sites of interest, You can find people with Spotlight too. Start typing the
simply type its name into Spotlight and you'll quickly find name of someone you know, and Spotlight quickly finds
what you're looking for, complete with a link to the Maps app and  that person in your Contacts list and displays their contact

the option of travel directions from your current location. Again, details in the results window. Things like chat threads, Facebook
click on the result to open. comments and emails are also listed.

R Mosbrhwad — A-tist on Apole Music - Metal - Longcn, Englard

Lost n The Ozone
B4 B - Mp3 Awdlo - Modifed 121072021, 501 pm

Nl Mg

37 KB - Microsoft Word Document - Modified 0411072005, 8:27 pm

Orthesr

7 Spotlight is also closely integrated into the core macOS Spotlight can find music by searching through your Music
apps, such as Photos. Start typing in your search term, collection to find albums, tracks and artists. Type a band

like the title of a particular image or photo aloum in your Photos name, a track name or even the name of a band member.

app, and Spotlight quickly locates it and takes you straight to it. Recordings with that name or by that band or person are shown.

Q Motorhead — test n he czone
- - D3 W - P Docurmsess - Modified T30, 7735 pe

.y MacFormat 265.pat
H #5 MB - Pdf Docurmen - Modified W6M1Z/7012, 6725 pm

Do “Show Mare BooksYIRIconClock.caar

6 KB - Fch Text Document With Atachmants - bodifed DIOYTOTE, 1170 em

Oilente & VWL . al hhin bl

A very useful feature in Spotlight is Quick Look

10 Another useful feature feature is Quick Actions. These let
integration. After doing a spotlight search, single-click

you instantly begin a process, such as starting a timer,

on a search result to highlight it, then press the space bar to running a shortcut, turning on a Focus and more. To start a
get a Quick Look preview. While previewing, move up and down  timer, for example, type ‘Clock’ find the Start Timer option and
the list with the arrow keys. click it for an in-Spotlight timer.
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B -irst Steps with macOS Sonoma

Launching Apps
And Quitting Them

There are several ways of launching an app on your Mac. You can: use the

| aunchpad, which is found in the Dock; you can open a Finder window and
navigate your way to the application you wish to use; or you can click on the
Spotlight feature and simply type its name. Here's how to do it.

Using Launchpad

Listond
e @ = a0 "QB 9« Ne AENmMZ B0= m@r2S50e="Q@ " @« Ne BENWHZO0 e

If you have more than one page of apps, move between

1 To open the Launchpad, go to the Dock and click on it, or
them by swiping left and right with two fingers or hold

place four fingers on your trackpad and bring them

together. The screen darkens and your apps are shown as cmd and use the arrow keys. Click and hold onan app and an ‘X’
icons. To launch an app from this screen, click on it. To close appears in the top left corner; click X' to delete. Not all apps can
_aunchpad, press Esc or click on the desktop. be deleted in this way.

|-@0= a8 B0 S@: -

You can arrange your apps into folders on Launchpad too, Open and close folders by clicking on and off the folder

3 just like on an I0S and IPadOS Home screen. Just drag icon on the Launchpad screen. You can add new apps
one app onto another and a folder is created. You can click on into the folder by simply dragging them onto the folder. You can
the name if you wish to change it and to remove an app from also drag apps around the Launchpad window to change the
that folder, drag it off the grey folder area. order in which they're arranged.
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Using Spotlight

1 To launch an app using the Spotlight feature, first click on

the magnifying glass found in the top right corner of the
screen. A window saying ‘Spotlight Search’ pops up. If it's
inconveniently located, you can drag it around the desktop and
move it to wherever you like.

Using the Finder

Fawoutiles

™ Documents

&) Downloads

= Desktop

B3 Essential Apple User Mag ss...

B9 The Apple Watch Manual (wa...
[9 Creative Cloud Files

Ci )
Deskiop.. .t Uninstaller  Campaign Edition

iChoud
% iCloud Drive

DMF“mﬂB
£ Macintosh HD

G@D.I..

Dropbox DVD Rippers Dx0 PhotolLab &

' Clone Storage Drive

F Clone Work Drive S
-1 Storage Drive

P Orico 1TB

4= CloudMounter - Google Drive

4 CloudMounter - OneDrive

43 CloudMounter - Work Dropbox

I WOMyCloudEX2

- -

You can also launch an app using the Finder. Open a new
Finder window (or use one that's already open) and click on
Applications in the sidebar. All of your Mac's apps are shown.
Scroll to find the one you want to use and then double click
on the icon to launch.

Quitting Apps

@' Long Exposure

(=] Pancramas
®, Screenshots
@ Animated

v &) Shared Albums
LC) Activity
wg Lovely people
gy Office Cat
"Y Best Photos

P& Family

v () My Albums

@ Roger's Funeral

F \.&

Open apps are shown in the Dock. On the app's Dock icon, you
can click using the right-hand side of a Magic Mouse or trackpad
(right-click), hold the Control key and click anywhere (ctrl-click) or
click and hold, then click on Quit in the pop-up window.

Begin to type the name of the app you want to launch and
Spotlight tries to complete it for you. When you see the
name of the app you want, scroll down to it and press Enter and
it launches. To close the Spotlight search window without
aunching anything, just click anywhere on the screen.

Using the Dock

\

You can launch an app from the Dock. If your Dock is hidden,
move your pointer to the foot of the screen to reveal it and
click on the app you wish to use. To find out more about the
Dock and how to customise it with your favourite apps, see our
tutorial later in the book.

1

e -

B
E

i
i

[ H

Alternatively, with the app to the fore in Finder, click on its name in
the top left corner and select Quit [app name] from the menu; or
hold the Command key and press ‘Q’. Just make sure the app is
open on your desktop or you might quit the wrong application.
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First Steps with macOS Sonoma

A

Setting Up Emaill
For the Mail App

With emaill, you can send mails and attachments anywhere in the world, at
the push of a button. Here we take a look at what email is, how you can get
yourself an email address and how you can use your email accounts on
your Mac, with Apple’'s bundled email client, the Mail app.

< . Apple ID

(©) Ppersonal information

B Sign-In & Security

E) Payment & Shipping
& iCloud

Media & Purchases

= Family Sharing

Devices
W Mac
. Thig Ikss 74"

E lan Osborne’s iPad Pro
Pad Pro
Accessibility
LJ Control Centre 8 lan's Apple Watch
S Apple Walch Sanes /
B siri & Spotiight
n Privacy & Security E lan's iPhone
Hhone 12 Pro

B peskiop & Dock

lan's Mac
ﬂ Displays £ aralledls

1 If you set up your Apple ID during your Mac's initial

setup, or if you signed in with an existing Apple ID, your
ICloud email account is already in place. But if not, or if you
want to add another iCloud email account to your Mail client,
follow these instructions.

M“nbﬂlﬂll it 5] = =T o . - L =

Netflix inbox - iCloud 1:48 pm Gruesome - Gory * Action Comady

i
lan Osborne, we've just added a film... A dysfunctional squad of supervillaing infitrates a remote island on &
A dystunctional squad of supervillains mission to destroy a secret government experiment. More Info
- infiitrates a remote lsland on a mission (0.
- o = -l i
TN T "W
== 1‘ -i - 1

st o T

= F
i
T

L L A.pp{a Inbox - Pipex emaill 11:12am
Your Appie D was used 1o sign in to ICio...
Dear len Ohbommne, Your Agple 1D

{ LI O Dornefo sl Dl e o= T ——

first direct Inbox - Bj Sign in to iCloud with your Apple ID.

Apple Pay Registration |I‘ ' Don't have an Apple ID? You can creste one far free.
You're Apple Pay ready Q Email or Phone Number ||

XX XXXX 6619 Dear N

first direct inbox - By photas, contacts and AT
Apple Pay Registration Lb‘ RETTI O AT Cevices
You'm atl ¢

B Now wour dala |'s managed
ou're all sot 1o go with'®
Apple Pay reacy (wel ng

orant Das ;
Job alerts from Googl Cancel
K23 2 new jobs for ‘media
Madia, communicaliang “.. Tthlals slsl g 3

et Meesages (iC Nowton AbbotAStatt Writer Adventurize 5. PRAMARY = SUBTITLES

Amazon.co.uk Inbox - Pipex 7:18am
Kindle Dally Deal: Discover top eBooks Ir...
Iép deats for vwou Stormbreaker [Alex Higoer

Baok 1] by Anthony Hormwit: £3.489 £7.99
Tile Inbox - Prpex emad 1:23an
Updated Terms of Service and Privacy P...
L vy [ o o A I s bl #

3 Now enter the Apple ID for the iCloud email account you
want to add to your Mail app, and then the password.
When you have confirmed your details you can then click on the

Sign In button to take you to the next step.
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Open the Mail application from the Dock and then under
the Malil drop-down menu found in the left of the menu
bar, click on the Add Account... link. From the pop-up menu that
appears, select the iICloud link and then click on the Continue
button to go to the next step.

lan Craborrss

i Ha: #Ehang 1 Pro
Te i b <) Ly

There's no sign of e nan agresment ypet. =

On the next screen, click on Add Account and your iCloud
account is added to the Mail app, for you to use on your
Mac. Your iCloud email can be your sole email account or you
can use it in Mail or alongside others if you wish.



Setting Up Other Emails
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1 To configure your Mac to access your email account from

your Intemet service provider, you need your email address,
your password to access your email account, and POP or IMAP
(incoming) and SMTP (outgoing) server addresses.

® Mail File Edit View Mailbox Message Format Window Help

| Ada Account...

==

Inbox = iCloud
4, 736 messages

® @

Favourites

v £ All Inboxes Netflix

= Exchange
&9 Talktalk

£9 Pipex email

& Google

> - VIPs

Netflix

. When you first open Mail you're prompted to set up your

first email account. If you've previously used Mail or set up
another account, you can add further new accounts by going to
the Mail menu and selecting Add Account.

[ to conquer,
acr e H A s

Add a Mail account

E[ To get started, fill out the following information:

Name: lan Osborne

Email Address: |hame@example.com

Ir 2 Password: Hequired

Cancel Sign In

agree

T T : e
T MV SLirnainn .
i ln’ 1Y ~Fhal 1 I8AT N Raae

If you're adding an account from your Internet Service
Provider, select Other Mail Provider from the screen in
Step 3. Enter details such as username, password and server
information provided by your ISP. The server information should
also be on the ISP’'s website.

: Setting Up E

macOS Sonoma includes a sophisticated email program,
simply called Mall. You can find it on the Dock, as it's there by
default. The Mail App's icon shows the back of an envelope on a
blue background. Click on this icon to open the Mail app.

P
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Microsoft Exchange

To get started, fill out the following information:

Name: lan Osborne

Sign In
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Click t

f it's another web-based email service you're adding, you
must now enter your full name (this appears in your own,
and other people’s, contact lists), your email address and your
password. Do this, and your account is added.

- N ] { > Pipex email

SeaEn Datails..

37 Leneral |
m Appearance |

(@) Accessibility
{7 Control Centre

) siri & spotiight
ﬂ Privacy & Security

Mail

Delete Account... ?

@) Desktop & Dock
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(.2 Wallpaper

Screen Saver

|| Eneray Saver

B Lock Screen

it Touch ID & Password
£ users & Groups

\J) Passwords

(@ |Internet Accounts

W Game Center

The information required depends on the ISP, but typically
iIncludes mail server addresses, your username, and your
password. Click on Sign In to finish. You can change your settings
later, in System Settings > Internet Accounts, or click the Mall
menu and click Accounts to go straight there.
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-irst Steps with macOS Sonoma

Installing New Apps
# Including T'hird Party

As you get to grips with your Mac, it's likely you'll want to install more
software, or ‘apps’. There are two ways to do this. You can use the Mac App
Store, just like you do on the iPhone or iPad, or you can download an app
from the Internet and install it manually. Here we show you how to do both.

From The App Store
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1 Downloading new apps from the Mac App Store is the You can use the Search field to look for an app by its
easiest way to get new software for your Mac. First open name, what it does and more, or simply navigate the App

the App Store app; you can use the Apple menu to open this Store using the categories in the left-hand sidebar. Note the

particular app, or the Dock, Launchpad or Apps folder. filters, opened by clicking the chevron in the top right too.

—-" Lockera Widgets
E
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Ratings & Reviews

Hice and claan Gireat but Caloulator is & bit laggy

N ard timee. weather 8ic . Bat alsa some taeaks e y

3 Scroll up and down for more apps. If button to the right
displays a price, that's how much it costs. If it says ‘Get, it's

Click on an app title for more information on that app. Click
its button to download it. If it's a paid-for app, follow the

free, but might offer in-app purchases. A cloud symbol means you on-screen instructions to make a purchase. If it's free, just click
already bought it but it isn't on your Mac; download it again for free. Install'. You might have to sign in with your Apple ID. When it's
f it says ‘Open’, you already have it. Click the button to opendit. downloaded, you can open it just like any other app on your Mac.
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From Other Sources
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1 Not every app is found in the App Store. If there's one you
want to install that isn't, first find its home page on the web,
and go to the Downloads section. Make sure you're downloading
the correct version for your Mac. Here we're downloading
Handbrake, the popular open source video transcoder.

“HandBrake” is an app downloaded from the internet. Are
you sure you want to open it?

i ivEm w8 o T digh mage “Handilyais-18.00mg" a7
gownigaded (ke ek image 1oday & 307 pm. Apple chacked o toe
malicious softeare snd nore was detecied

3 The app usually downloads as a . dmgimage, that is, a virtual

disk. Double-click on it to open. The window here shows
what's inside the downloaded file; the app and a folder containing
documentation. Double-click on the app to open it. Because it's not
from the App Store, you're asked if you want to open it.

m Apple Advertising

Security

Allow applications downloaded from
App Store
O App Store and identified developers

“DeSmuME" was blocked from use because it is not from an
identified developer.

Open Anyway

S m_Lﬂ.AkdmAm_U.nd.n e

If you get a warning like this one, saying the developer
could not be verified, it's still possible to open the app.
Open System Settings and go to Privacy & Security. Scroll the
window up until you see the Security section, and click the Open
Anyway button. You do so at your own risk, of course. Be careful.

A

| Installing New Apps
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3. % HandBrake
The open source video transcoder
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Downloading ...

I yvour dovwnlocad does not start automatically, please click the flilename below
File information:

File Name: HandSrake-1.6,1.0mg

File Size (MB): 41.32 M3

SHA 256 3af46b84c11011127c09B8581c1070d47263563c4MI2 T 3edeb2 BOI08B5e6863 [Github Mirror)
GPG Signature: Hand8rake-1.6.1. dmg.sig (Hosted on GitHub)

GPG Public Key:  Public Key information (Hosted on GitHub)

Installation Instructions

We provide an installation guide within our documentation,

& The HandBrake Team | Privacy Palicy | Report Problem Website by Ethercycle

Click the download link, and the app downloads. If you're
using the Safari web browser, click the down-pointing arrow
icon to open a pop-up window showing how much has downloaded
so far. [t may take a long time if it's a big app. When it's done, the app
s found in your Downloads folder in the Dock or Finder.

Opt to open it and the app opens; you can Now use it on
your Mac. If you want to use the app more than once, it's a
good idea to drag it out of the disk image window and into the
Applications folder as shown, which is found in the sidebar of
most Finder windows. After that, you can bin the .dmg file.

Using Installers and
Downloaders

Larger apps might download an installer, which installs the
app automatically to your Applications folder, or a
downloader, a small program that downloads the app from
the Internet before installing it. If this is the case, simply
follow the on-screen instructions as they appear. There's
nothing difficult about it.
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NEMOLS
Sonoma'’s
Key Apps

One of the best things about the Mac is the
great apps that come bundled with macOS.
For web browsing, there's Safari. For emails,
check out Mall. Keep your scribblings in the
Notes app, plan your events in Calendar
and store your addresses in Contacts. We
cover all these and more, including new
Sonoma features such as Dock
Applications, Safari Profiles, the new
Screen Sharing app and more.




1 macOS Sonoma’s Key Apps

Your Web Browser

Safari is your Mac's web browser. You can explore the worldwide web, enjoy
your social media accounts, do shopping and more.

With macOS Sonoma, Safari gets new
features like web apps and browsing profiles.

his icon opens and closes the
sidebar on the left. Close the
sidebar to see the Profiles button,
which lets you switch between
browsing profiles you've set up.

Here you see how many tabs you
currently have open in Safari. A
chevron to the right shows and hides all
those tabs in a list here in the sidebar.

This icon gives you a menu that
lets you make a Tab Group of
the tabs you currently have open, or
start a new, empty Tab Group to
which you can add tabs manually.

These two chevrons are your
navigation controls, which let
you move forward and backward
through your browsing history:.

These icons are for Safari
Extensions you've added. To
add extensions, in the top bar's Safari
menu, select Safari Extensions. To
manage them, select Settings from
that menu and click Extensions.

Click the Page icon to show and
hide the site’'s Reader view.

7 The URL Bar. Enter the website
address or a search term that
you wish to look up into this bar, then
tap Return.

The firsticon lets you translate
the website you're looking at
into another language. The second
reloads the website, perhaps if it's
stuck or might have been updated.
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Click here for a list of items
you've recently downloaded.
When you're currently downloading in
Safari, progress is shown here too.

Click onthe Sharing icon to see
your options for sharing the page
you're viewing; adding it to Notes,
making a Quick Note and options for
Add Bookmark and Add to Reading List.

Click the + icon to open a new,

blank tab. You canthen go to a
new website without closing the one
you're currently viewing.

This takes you to the Tab
Overview, showing all your
open tabs as thumbnails in the main
window. Click on one to open it.

These are sites that you've
pinned to your tab bar, where
they remain. Although smaller, they
function just like regular tabs. Click on
one to open that tabbed site.

These are your currently open
tabs. Click on one to open i,
hover over the tab and click the 'X
on the left-hand side of the tab to
close it, and click the '+ icon (ltem
12) to open a new one.

Your Tab Groups. Click a group
to close the tabs you currently
have open, and open the group of tabs
you selected. To return to the tabs you
had open beforeg, click the ‘X Tabs’
option above it (item 2).

1 B B

&€ Safari File FEdit View Histoy Bookniarks Window Help

& Personal — 4 Tabs

|0¥IE&L£

-f)) WK1

The Free Er

[[) History Of The Mac

() Amazon Echo tabs

©) Devon Trip
[ The Cats
[ Social Media Contents [hide]

(Top)
» History

U Getting started with...
B Twitter. Alles, was ge..
P International Skeptics > Products

[©) Instagram > Marketing

TikTok - Make Your D... » Corporate affairs

¥ Electronics, Cars, Fa... > Finances

A Rescue, Rehome and... > Environment

> Supply chain
See also
Notes

> References

Further reading

External links

Ll Bookmarks

OO Reading List
&% Shared with You

< iCloud Tabs

T EE——————————



This is where the web page

can then scroll up and down by using

you're viewing is displayed. You Browser

the scroll function on your mouse or TI‘aI‘IS|ati0nS

trackpad, and navigate to new pages
by clicking on links, which can be
menus, buttons, text or images.

17 ere you can open your
Bookmarks or Reading List, see

websites shared with you in Messages
and tabs open on your other Apple
devices, shared through iCloud.

If you're looking at a foreign-
language website, click the

Translate icon in the URL
field and you can translate it
into your own language. You
can also open the Settings

options for preferred
languages from here.

@ enwikipedia.org

B (2) YouTube & Buy iPhone 156 Pro and iPhone 16 Pro Max - Ap...

Translate to English
& Buy iPhone 15 Pro and iPh

iten Quelltext bearbeiten

e Q M

& Preferred Languages... eite Beitr

lia durchsu

10

@ 2

AWM Guide | AVM International

© & + ©

11 12

0N DI~

« Mon300ct 11 156am

Ii_::l..'l.'!l:}|]t'lll":l

Bearch Wikipedia Search

Apple Inc.

Article Talk

From Wikipedia, the free encyclopedia

(Redirected from Apple inc)

Read View source

N¥a 146 languages v

"Apple (company)" redirects here. For other companies with the same name, see Apple (disambiguation) § Businesses and organisations.

Apple Inc. is an American multinational technology company headquartered in Cupertino, California. As of
March 2023, Apple is the world's biggest company by market capitalization,'® and with US$394.3 billion the
largest technology company by 2022 revenue.”! As of June 2022, Apple is the fourth-largest personal
computer vendor by unit sales; the largest manufacturing company by revenue; and the second-largest
mobile phone manufacturer in the world. It is considered one of the Big Five American information technology
companies, alongside Alphabet (parent company of Google), Amazon, Meta Platforms, and Microsoft.

Apple was founded as Apple Computer Company on April 1, 1976, by Steve Wozniak, Steve Jobs (1955-
2011) and Ronald Wayne to develop and sell Wozniak's Apple | personal computer. It was incorporated by
Jobs and Wozniak as Apple Computer, Inc. in 1977, The company's second computer, the Apple |l, became
a best seller and one of the first mass-produced microcomputers. Apple went public in 1980 to instant
financial success. The company developed computers featuring innovative graphical user interfaces,
including the 1984 original Macintosh, announced that year in a critically acclaimed advertisement called
"1984". By 1985, the high cost of its products, and power struggles between executives, caused problems.
Wozniak stepped back from Apple and pursued ures, while Jobs resigned and founded NeXT,
taking some Apple employees with him.

As the market for personal computers expanded and evolved throughout the 1980s, Apple lost considerable
market share to the lower-priced duopoly of the Microsoft Windows operating system on Intel-powered PC
clones (also known as "Wintel"). In 1997, weeks away from bankruptcy, the company bought NeXT to resolve
Apple's unsuccessful operating system strategy and entice Jobs back to the company. Over the next decade,
Jobs guided Apple back to profitability through a number of tactics including introducing the iMac, iPod,
iPhone and iPad to critical acclaim, launching the "Think different" campaign and other memorable
advertising campaigns, opening the Apple Store retail chain, and acquiring numerous companies to broaden
the company's product portfolio. When Jobs resigned in 2011 for health reasons, and died two months later,
he was succeeded as CEO by Tim Cook.

Apple became the first publicly traded U.S. company to be valued at over $1 trillion in August 2018, then at
$2 trillion in August 2020, and at $3 trillion in January 2022. In June 2023, it was valued at just over

$3 trillion.'® The company receives criticism regarding the labor practices of its contractors, its environmental
practices, and its business ethics, including anti-competitive practices and materials sourcing. Nevertheless,
the company has a large following and enjoys a high level of brand loyalty. It has also been consistently
ranked as one of the world's most valuable brands.

History

Main article: History of Apple Inc.

MacBook
e

=

Apple Park, the company's headquarters in

Apple Inc.

Cupertino, California, which is part of Silicon

Formerly

Type

Traded as

ISIN
Industry

Founded

Founders

Headquarters

Number of

Valley

Apple Computer Company
(1976-1977)

Apple Computer, Inc.
(1977-2007)

Public

Nasdaq: AAPL £
Nasdaq-100 component
DJIA component

S&P 100 component
=&P 500 component

U50378331005

CDﬂEUFT‘IE!‘ electronics
software services
Online services

April 1, 1976; 47 years ago in
Los Altos, California, U.S.

steve Jobs
Steve Wozniak
Ronald Wayne

1 Apple Park Way, Cupertino,
California, U.S.

526 retail stores (2023)
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A

Create account Login
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Set New Home Page

. About Safari
Safari Extensions...

File Window Help

Edit View History Bookmarks

Settings...

Privacy Report...

Settings for apple.com...
Clear History...

Create Profile...
Services

Hide Safari
Hide Others
Show All

Quit Safari

Open a new Safari window and navigate to the web page
that you want Safari to load each time you launch the app.
Click the Safari menu (top left corner), then select Settings to
display Safari's preferences dialog box.

General

{3 = Q a8 M & A& er g

General labs Autakll Hassworos Searcn security Hrivacy Wwehsites Profiles

Safari opens with: A new window

New windows open with:

8
Start Page

Start Page

Mew tabs open with:

Remove history items: After one year
Start Page Favourites: <y Favourites B
File download location: & Downloads
Remove download list items: After one day >
Open “safe” files after downloading
\ J

Ensure the General tab is selected and press the Set to
Current Page button. The required page address now
appears in the text box above. It's now your default home page.
The Home menu in the toolbar will take you there.

Using Links

Shop Mac

All models. Take your pick.

MacBook Air 13° with
M1 chip

MacBook Pro 13"

MacBook Pro 14" and 16"

%

You navigate the Internet in Safari using hyperlinks, or simply
'links’. A link can be a piece of underlined text, a picture, a
button or simply an area of the screen. To open a link you'll
need to move the mouse pointer over it and click. When the
pointer is over a link, it's replaced by a hand.
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Accessing Websites

B 4 & V9@ 8BS C8 N oK O

@ @ | T www papercut.com— Go to Site D C| --H M

Kinge www.papercraftproducts.com

www.paperchase.co.uk

wWWWwW. papencut .com

Google Suggentions
L www.paperc
L www.paperchase
O www.papercraft

Q. www.paperculz.com geronimo stilton

To access a new website in the Safari browser, first
double-click in the URL bar, highlighting the text within it,
then type a new URL in this bar. A URL is the website's address,
which starts ‘www'. Press return at the end to go there.
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f you want to search for something on the web, instead of
typing a URL in the URL bar, type what it is you're
searching for, then hit Return. Your search results show relevant
sites. Scroll up and down the list and click one to go to it.

Pay in monthly instaiments for your
new Apple Watch, iPad or Mac.****

Spread the Co#l of yoaar nerw OPCo Owee 10 14 o DB mperihs

B o el i o Y

Howr thions Tinancing work'?

Clicking a link takes you to a new page or opens a new window
based on what you've just clicked. If you don't want to navigate
away from the page that you're currently on, right-click or
Ctrl-click on the link and from the pop-up menu, choose Open
in New Tab or Open in New Window.



Add Tools to the Toolbar

@ Safari File Edit View History Bookmarks Window Help

Customise Toolbar... 5

o Always 5t b Bar @ @
Show Favourites Bar

Hide Status Bar : o) @ Buy Mac - Appla (UK) A Rescun, Rebome and Adopt a Pat

Show Sidebar ‘ Slore Mac Pad iMhone Watch AirPods
Show Bookmarks Sidebar
Show Reading List Sidebar
Show Shared with You

Spread the cost of your new Mac ove

Show Reader
Show Tab Overview
Show Downloads

- Mac

.'1 [ '. slation »

i “Text Encoding » Ways to Save Shopping Guides Accessories Setup and Support

All models. Take your pick.

NEW 15" MODEL

1 Right-click or Ctrl-click on the toolbar and select

Customise Toolbar; or click the View menu and select the
option from there. A window slides down. To add a button to the
toolbar, simply drag it from the selection in the window onto the
Toolbar within the Flexible Space sections.

All models. Take your pick.

MacBook Air 13" with MacBook Air 13" and 15"
M1 chip with M2 chip

MacBook Pro 13° MacBook Pro 14" and 16"

Repeat this with as many tools as you need. When you're
finished, click Done. To remove a tool from the toolbar,
simply drag it out of the toolbar, release and it vanishes. To
reset the tools to how they were originally displayed, drag the
default set of tools onto the Toolbar.

Status, Favourite & Tab Bars
‘ Safari File Edit 7 View = History Bookmarks Window Help > “

 Always Show Tab Bar @ #]
Show Favourites Bar

v Always Show Toolbar in Full Screen
Customise Toolbar...

Hide Status Bar - :‘J & Buy Mac - Apple (U
Show Sidebar @ Store
Show Bookmarks Sidebar :

Show Reading List Sidebar

Show Shared with You

Show Reader
Show Tab Overview
Show Downloads

yMac

Translation >

aload Page

— = - - e as [ = - — . - & e R

iActual Sizc

You can show or hide the Tab, Favourites and/or Status Bar (a
strip along the bottom of the window showing the full URL) by
clicking the View option in the menu bar atop the screen, and
selecting the option in question.

Pinned Sites

® @ @ animalsindistress uk.com Gpc ¢

¥ M e (UK . s in Distress... YouT
@ Buy Mac - Apple [UK) ,fﬁh: Pin Tab wls in Distre B (2) YouTube

Duplicate Tab

Rehoming About Supportus Shops Close Tab

Close Other Tabs
Close Tabs to the Right d .
Move Tab to New Window

T
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Arrange Tabs By > .
e g
= ~ AR
- _a_ll'_r--\_"l-:-C-'_: a\- ."‘;. '.‘. l! I'It:l' :... i
- e - :-H:;'.I.\ 1"*.,. ] F:r ij': 4
:i"', = - :'_ - 'h-:." b ; "_.| =~ _‘ -

ahy L'
.-._1_.:_\_‘: '|. L..' \" I|I| i 'r'l

e — [
e
= L 3 - el = -4 .
- o It..-'-'._‘q,_ . " Lk L]
l 1

P, o 2
i -

U
r {

: - .- f-l - 1 ..
:_-.r = ' \ 1! 1

elp us to change
of pets in neeg

|5

™ i N
- e -
¥ e '—!.."' -
2 o] - B . .
. T
AR ' ¥ d H F L _-‘_ ": r - =

- e 3 _'r. - L i -

1 o : 1 e

= S - 3 "
1 - o o,
. - IR S 3
; -
= i o i s - y

If your tab bar isn't showing, go to the View menu and
select the Always Show Tab Bar option near the top. Now
open the site you intend to pin and right or ctrl-click on its
tab. From the pop-up menu, select the Pin Tab option.

eve M- « ® @

ﬁrlﬂrEWS

J{ Animals in Distress

& Buy Mac - Apple (UK)

Home Rehoming About Supportus Shops Ne

Please help us to change

the lives of pets in neeg
- 1

&

The site gets a small tab in the left-hand side of the tabs
bar. This is always in place, ready for you to click on it and
open the site. You can pin multiple sites in this way. They
all appear as small tabs, showing a symbol or letter.

ene M-~ ® @
ﬁ'lﬂﬁiﬁwﬂi

Duplicate Tab

J{ Animals in Distress °°°™  ehoming About Supportus Shops Ne

@ Buy Mac - Apple [UK)

Please help us to change
the lives of pets in neeg

-

—_—

To remove a site's pinned tab, right-click or Ctrl-click on it
and from the pop-up menu, select Unpin Tab. The previously
pinned tab then becomes a regular tab. You can reorder
your pinned tabs by dragging them within the tabs bar.
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Bookmarks and Reading List

2 M © 0 +

Publications | Digital

pclpublications.com .
sives FAQs Contact (&Y B PaveLTites
@ %
uﬂtiﬂns A" Pu blicatiﬂns Alison Paper{:ut James Mark
g Willis Crew Gale Ayshford

Cancel Add

ws Add to Reading List
(O Add Bookmark

& Add to Quick Note

= Add to Dock 8t ot
' R )
) Email This Page hﬁ%‘_ _

1 You can save a website you're likely to return to oftenas a When adding a bookmark, a pop-up window appears. You

Bookmark. A site you're interested in but don't have time can add a custom title for the website you're saving, plus
to read can be put on your Reading List. Both options are there's an optional description field and a pull-down menu that
available from the Share icon in the toolbar. lets you add your site one of your bookmark folders.

[:] < @ [#] =] ® [ 4 {S:) @ & pclpublid
< Reading List O v B @ & T w )
¢ Bookmarks O v B @ & T w
Macintosh - Search..
. w [— 7Y Papercut  sec Q
Q. Search Bookmarks 3 pnpercut Sseqarcn... enwikipedia.crg
» 9% Favourites SN Apple For Beginners Coding & Computing Photography & Photog
> B3 Bookmarks Menu P R S s " R
pple or Beginners oding omputi bR
> [@ Tab Group Favourites e

Home | Thanyia
Moore
thamyiamoore co,uk
Thanyia is an
aciress, comedian,...

LeAple ooeninNewTab

> B3 RetroEngine Sigma Open in New Window
> B3 News Open in Tab Group >

_ d
> B3 Kids Rename e
3 Spons car Aol aster vyou foun Pvthon. C++
> B3 Entertainment o e y y
, Apple TV 8K
> B9 Shopping Delete . :'ppll:rn .
alc ppie *

2 E Travel movies and shows ...
New Folder
> B3 Tools and Reference - . Fenty Beauty: How
ites bbc.co.uk

3 To access your Bookmarks and Reading List, open the In the Reading List, drag a site left to save it for offline

sidebar and click on the option, found at the foot of the bar. reading or to delete it. The right/Ctrl click menu has an
Click a site to open it. In the Bookmarks sidebar, as shown, you can  option to remove/delete a site from either list. Click the small
right/Ctrl click and add a new folder if you wish. chevron, top left, to return to the regular sidebar.

The Start Page

rlimuk Fresh, https:/|

T r,|:
Gaming -.. Fearless|.. forums.x..

B nie Use Start Page on All Devices
o@En ¥ '
=R0RR e ¢« £ S noE ;4" % Favourites
LR i ke e A L i e T i v = ool 4 Ll ] rar-. sy @ F'Eq ue ntly uiaited
- ECT FRCGELD

a-o - BBC Nintendo Essential ~%s Shared with You
-l A e e LT — — Fil bt Wary s MLy e (s Life - Nin... iPhone &...
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R I R R i & Siri Suggestions
BZuc=0+«0000 ¢ @ - s
e e R R T Rl — il S — [C) Recently Closed Tabs
s DSo==@lB@¢Bc 8 O iCloud Tabs
— at g SISO B i aet sl Background Image
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NT«000> « @« D +
Frequently Visited

| R 1T
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= g =
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Start Page gives you a window full of useful shortcuts to your To add a site, click the URL field to open the Start Page and
most frequently visited sites alongside its default choices. Click  drag the URL into it. You can drag sites and folders into this

on the URL field at the top of the browser or in the Bookmarks window from your Bookmarks too. Drag icons around the Start
menu. Select, Show Start Page to access a window showing a Page to reorder them, or drag out of it to remove them. Click a
grid view of website icons, along with those you've visited most Show More/Less link to expand/contract lists. Use the icon
recently and the default links to other sites. (bottom-right) to include or exclude Start Page categories.
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Tab Groups

eve [ & <
& 5 Tabs - New Empty Tab Group B @ W
New Tab Group with 5 Tabs
lab Groups =
History Of The Mac

Amazon Echo tabs

©) Devon Trip

The Cats

Social Media

Shop N

1 Safari lets you save groups of tabs. You can then open a
group of tabs, temporarily closing what's open at the
moment. Open the sidebar, then tap the New Tab Group icon in

the top-right of the sidebar for a menu.

T—

® @ [11 Steve Jobs— Search Google ] A M
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3 With your new tab group open (see the highlight in the

sidebar), tap the + icon (top right) to open a new tab, then
navigate to the site you wish to save in the tab group. Do this as
many times as you like to fill your tab group.

Shared Tab Groups

eve ¢ < ®
&4 0 Tabs € Buy Mac - Apple (UK) B (2) apple 1
Tab Groups ‘ Store

Apple Mac sites

[ N B LU i . A& .

@ :a Collaboration

8 e @ &

Alison Papercut James Mark
Willis Crew Gale Ayshford 0 p a c
L+ Messages

er Edit Extensions...

- A

In macOS Sonoma, you can share a group of tabs. Just the
thing for when working on a group project. To do so, hover
the pointer over the tab group in the sidebar, click the three-
dots icon and select Share Tab Group.

r Safari

L= O Tabs & Buy Mac - Apple (UK)

@0 Medium O search

Tab Groups

‘Wl Apple Mac sites] - b
History Of The Mac

u

Amazon Echo tabs

Devon Trip

O 0 0Jd

The Cats

O

Social Media

From the menu, you can make a group from all the tabs
you currently have open, or start a new, empty group and
then add tabs to it. We'll do the former here. Either way, you get
to name the new tab group. Press Return when done.
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Use the sidebar to switch between tab groups and the
tabs you have open on your Mac. Tap a tab group and
then tap the chevron to its right for a list of tabs. Tap the icon in
the top-right corner to see tabs as thumbnails.

Tab Groups Start Pages
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Each tab group can now have its own Start page, which
you can customise. Click on a tab group and click the +
icon to give it a Start page. Click the bottom-right icon
and you can customise this Start page.
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Private Browsing

File  Edit View History Bookmarks Window Help

New Window #$ N

New Private Window 3N

New Tab dT
New Empty Tab Group ~ 3N
Open File... #* 0
Open Location... it L

Close Window
Close All Windows
Close Tab

Delete Tab Group

1 Private Browsing lets you browse the Internet without adding

tracking cookies or recording where you've been in your
history. Activate Privacy Mode by selecting New Private Window in
the File menu. In a private window, the URL field is darkened.

Private Browsing Is Locked

Privacy Toiech K of gnied [P padsedrd 104 The Ui

; = , e Orabadrd " B wSie ke taha
& D ef § Q 8 6 ® & B %
« [T, Ty PP T R — wouwrily  Peany Websiles Profies  Erfensons  Adviesomd

WBbRnE Drkch g E Prasedil cfoas- Siteé Tracking

Hids [P vy ﬂ Hide 1P addroms  Prom Trachers amd Webdines B

Private Browsing: B Require Towch 1D S0 wiisy boo ks tabs

Private Browsing windows are locked when your Mac
goes to sleep, and have to be unlocked on an individual
basis with your password or Touch ID. To change this, go to
Safari > Settings > Privacy and uncheck ‘Require Touch ID to
view locked tabs'.

< » iCloud

Apps Using iCloud

I L e TR [ wi T el L Gl & 8
e vislling Lsarn mofe.

IP Addrass Location
idn i L [V i

Aooesy youF Wi, coninely, caleniar, pholox, notes, reminders, (das and
dacuments on Uhe web 8l IDlold com nd privacy.apple 2om. Laam more...

3 If you have a paid-for Cloud subscription you can turn on

Private Relay, which prevents websites from viewing your
IP address. To turn it on and off, go to System Settings > Apple
ID > iCloud and under Private Relay, click the Options button.
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Taillor Site Settings

iy ok RAGIE Sl
N Block ama Malify
mgra:  Ask
respiuineg’ R
| 50 aireg; Ask
ion: Ask
E Spamass
B2 D00 Bt
Deutsch
B33 D0+ Adt
italiano
ey

-:'.ﬁ Fosd Wikipsdia in your language

1 There's a number of useful tools for tailoring your

experience on a per-site basis. Open the website and in
the Safari menu, select Settings for [the website]. You can enable
or disable content blockers, go straight to Reader View, change
the page zoom, stop auto-playing videos and more.

Ei] & wikipedia.org

When visiting wikipedia.org: t Fermi Paradox | IFLS

Use Reader when available .
cerely: don’t cliq
Enable content blockers

Page Zoo  Allow All Auto-Play

NERZ v Stop Media with Sound |

Pop-up Windov  Never Auto-Play

Camera: Ask
Microphone: Ask
Screen Sharing: Ask
Location: Ask

rruﬂKHﬁ
1938 000+ cTaTte#

Espaimn
1892 000+ articulos

Deutsch
2 836 000+ Artikel

Francais
2 553 000+ articles

Page Zoom and Auto-Play are set with pull-down menus that
appear when you click their current values. By default, the
Auto-Play function stops videos with sound automatically playing
but you can override this using the Auto-Play menu. These settings
are applied whenever you load that site.

The Reader View

F

Apple Inc.
Mppde (company)” redinects hane. For other companies with He same nemg, see
ASDie [ SEETORJLET 0N § BuknfISEs g SrgenEaiorg

Apple ing, is an Amedcan mutinational techrokogy company headguarianed in

Cupartisg, Callorria. As of March J0 3, Apple i 1he workl's Bggoal compasy

Iry uldlbl Caghi-F it o _:“' el et LS5 38 T Bl [Pl L e i1 T Muiate iy
mpary by 2027 reverwe |l As of June 3022, Appie s the fourth-lergeat

peer sonal computer vencdor By unilt saies; 1he largest manufsclsing comaany By

Y L g T A OnG - L e rnoild pROrss marul acturar i th workd, Il i

Condarad ol of (Pl Beg Frdé AMRBCEn morMEha |SChnSogy SO,

slongside Lptabet (parent company of Googie|, Amanon, W T

T p———

Appie vt founded as Apple Computer Company on Agril |
Varmess, S1ev Jotd [(TRSE=2017) and Ronald Weyne 1D g =

Sl ) il gl e 2 TR el
il o - [
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a5 Apphe Computar, Ine. in 1977 The comgany’s. secomt oo [ omemocnen
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went public in 1980 1o instant financial success, The compan L Ao R = B
computss festurng nnovalive grastcal it mis e, ngl L‘:L [ — A — = 8
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If a Page icon appears in the left of the URL bar, that site can be
viewed in Reader View. Click it to toggle Reader View on and off.
Right-click on this icon for a settings window, that allows you to

set some sites to automatically open in the Reader View.




Getting More from Safari

@ animalsindistress.uk.com i QM
Anim... * BB (2) Pentagram - Live at Wacken Open Air 202... §* A e e T T e i e ———| Digit}
Mute This Tab
Enter Picture in Picture
DONATE Auto-Play >

1 3 (2) Pentagram - Live at Wacken Open Air 2023 - YouTube

Tabs Audio Indicator

f atabis playing audio, it has a speaker icon on its right. Click this
to toggle the sound on and off without having to open the tab.
Right-click on the icon for an options window, which lets you mute
more than one tab at once, or use Picture-in-Picture.

¢ Back to Tesco.com

Sign in to your account

New to Tesco? Register for an account

Email address

jan.osborne@dsl.pipex.com

Password

njcow-vafko2-woctiV Hide

I've forgotten my password

b A

Suggested Passwords

When setting up a log-in account in Safari, the app suggests a
strong password for you. If you choose to use it, you can edit it
INn case it doesn't fulfil the site's specific requirements. You can
review all of your web passwords by opening Settings in the
Safari menu, and clicking on Passwords in the toolbar.

Integrated Spotlight Search

Spotlight search is a tightly integrated feature of macOS,
including Safari. From the search bar you can find links to web
pages, bookmarks and browsing history; simply by typing a
search term. Click on one of the responses to open that
particular website in your browser.

Safari File Edit Bookmarks

View History Window Help

About Safari
Safari Extensions...

Settings...

Privacy Report...
Settings for en.wikipedia.org...

Clear History...

Create Profile...

O v B @ & J

Contep

Clear Browsing History

In the Safari menu, there's an option Clear History, which erases your
browsing history and website data. Hold Alt while you select it to
delete your browsing history, but not website data. In the pop-up,
choose whether to delete all or recent history with the pull-down.

=
(Top) From Wikipedia, the free encyclopedia

> History
"Apple (company)" redirects here. For other ¢

> Products
Apple Inc. is an American multinational technoiq
> Marketing .
March 20232 Annla iz the wnrld's hinnast compaj
® Search snue.l”]

@ D= % Q 8 6 ® & B 8 b
General Tabs AutoFlll  Passwor ds Search Security Privacy Websites Profiles Extensions Advanced il is con
ampany
Search engine: Google Comp4

Private Browsing search engine: DuckDuckGo (g sell Wc
Include search engine suggestions = |

wduced

Smart Search Field: Include Safari Suggestions ad com
Enable Quick Website Search  Manage Websites... nounce|

Preload Top Hit in the background icts, arn

Show Favourites irsued

As the market for personal computers expanded
market share to the lower-priced duopoly of the

clones (also known as "Wintel®). In 1997, weeks
Apple's unsuccessful operating system strategy

Jobs guided Apple back to profitability through

Change Your Search Engine

To change the search engine Safari uses by default, select
Settings from the Safari menu. Click on the Search tab and
from the pull-down select the search engine you want to use.
You can use different search engines for regular browsing and
for private browsing if you wish.

o "I ¥} =] b . d 1 [t : E} :?;.J

Haramr b Sl

- v
& e DBl Sy gy O v I8 1T ol € e e T L R e i
LAl e

11 fapThed

Safari Extensions

To extensions to Safari to expand its functionality, open Safari's
Settings window (Safari > Settings) and select Extensions. Click
More Extensions to access the App Store's extensions page,
from where they can be installed. Your extensions are synced
across your Apple devices through iCloud.
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Add a Website to the Dock

& Safari UFile Edit View History Bookmarks Window Help

Naw Window aEN
New Private Window ORN
New Tab 1
New Empty Tab Group %N | < ® @
New Tab Group with This Tab

Open File... s >

3 Pnpercut Search..

Apple For Beginners Coding & Computing Photogr

Master photo
editing with
Photoshop

1 You can add a website to the Mac’'s Dock, and useitasif it
was a stand-alone application. In Safari, open the page you

want to add to the Dock as a Web App. In the top bar's File menu,

select the Add to Dock option found towards the foot of the menu.

.

3 Take a look in your Mac's Dock. The new Web App is

there, and has the name you entered in the previous
step as its app name. It also has the website's icon for an app
icon. You can launch this app from the Dock, just like any
other Dock application.

N —

%) Papercut  sco

Apple For Beginners Coding & Computing Photography & Photg

1rn to code

s ux & more

Click onthe app’'s name on the left-hand side of the top
menu and select Settings. A window appears. In this window,
you can edit the name of the app and/or its URL, change its icon
and more. The Privacy tab gives access to still more settings.
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‘abhic

(= Add to Dock

m ﬂ s Papercut Lid

https://www.pclpublications.com/

An icon will be added to your

_—

Dock and Launchpad so you can quickly access this website.

Cancel Add

A\

if necessary. Short app

In the window that pops up, you can edit the name of the
site, which is to be the Web App’'s name, and also its URL

names work best. When you're ready,

click the Add button in the bottom-right of the window.

73 Papercut

Appl0  ForBoginneds Coding & COMPUEng  PHOOgROphy & Photoshop  Smanphones & Tobiets  Prind Publicotions A Publicotons

Improve your
photographic

skills & mo

The app, when it
website. You can

B0= o@esS0®"~0@ -

from Launchpad or Spotl
into the bin from the Appl

re

IS opened, functions just like the
navigate from page to page using

INks, enter text in text fields and move forwards and
backwards through your browsing history with the chevrons
in the (mMuch-simplified) toolbar.

JBeUD s

You don't have to keep a web app inthe Dock to use it as an
app. You can also find it in the Applications folder, or launch it

ight. If you want to delete it, you can drag it
ications folder, like any other app.




Safar

Safari Profiles

i ™

Profiles
& O0=x § Q 6 O & & B @

- General Tabs AutoFill Passwords Search Security Privacy Websites Profiles Extensions Advanced

g el e
i nr-hu.:-.n- . L -u TN PU— [ -

o
‘ T- .y
Slllsource rp._-‘ti‘ y
Profiles allow you to keep your personal browsing separate from your work or school browsing.

Keeping your home
ando

Ce green ‘u Your history, cookies and wabsite data will be separated based on which profile you are using.
You can also manage your extensions independently for each profile

A =

When you start using Profiles, a Personal profile will be automatically created for you based on
your current settings. You can name your second profile, give it an icon and also set custom
Favourites. Learn more...

Start Using Profiles

1 You can divide your browsing into profiles, allowing you to In the Safari app, click on the word ‘Safari’ on the left-hand

divide your saved websites into groups such as ‘Personal, side of the top bar. From the menu, select Settings. In the
'Work' or ‘School’. Each Profile has its own favourites, cookies, Settings window, click the Profiles icon in the toolbar. As this is
browsing history, Tab Groups, Safari extensions and website data. your first profile, click the Start Using Profiles button.

Name: For Work .
T i -
—y _ Fovourites:  Create now Bogomarks foider
svmbﬂl: E # } m L :“ . D Use ecnaiimg foicie
ina. 1.4 + 1 Favourites

Colour:

-

' © " carks folder
' o .
c:_ﬁ L # H |
® 0O
&
X v;,

L B9 My Dok Live Duc
B9 Bitcrents

B © Ments heatn
@ . s P Dintel and Pracy
5 Days Out

B Travel

B Techie statistics
B eBayPayal
B Digital Sigrags

You can create a new Favourites folder for bookmarks

3 Choose a name for your profile. You also get to choose an
to go with this profile, or if you already have a folder

icon representing what the profile is for — click the

three-dots icon for more choices. You can also give the icon a containing the bookmarks you wish to use, click Use Existing
new background colour; click the rectangle next to Colour and Folder and select it from the menu that appears. When
choose one from those on offer. finished, click Create Profile.

® @

Profiles

Q 8 & ® & &

Privacy ‘Websiies Proflles Extensions Advan

%) Papercut  sooren

Protfiles allow you to keep your browsing separated. You may want to set up a profite for work or schoal. Your history, cookies and APFIE For EEng‘II"IEI"‘E Cndmg & E{:mputlng P

website data will be separated per profile.

& Personal (Default) General Extensions

Select which extensions you would like to use with this profile.

B Dpownload video

8 & @& & & S
Privacy ‘'Wabsitns Extensions Advanced

Genara Tahs AutoFil Passwords Search  Security Profilss

Profiles allow you to keap your browsing separated. You may want to set up a prolile for work or school. Your history, cookies and
website data will be separated per profile

“5% G App Launcher (Shortcuts for Google™)

ﬂ Ghostery

m Save to GoodLinks

MName: Personal
symbo: H & & A B @
Colour: [P*™

Lt |

You can make a few customisations on the next window Customise the default '‘Personal’ profile by clicking it in
(which you can open at any time using Safari > Settings > profiles settings. Click the Plus to add a new profile, or
Profiles). Click Extensions, and you can choose which extensions click a profile and click minus to delete one. The pull-down
are active with the profile selected on the left. menu in the browser toolbar lets you open a new profile.
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macOS Sonoma's Key Apps

Mail
Send & Receive Emall

Sonoma has a great bundled email application, so sending and receiving
emaills is as easy as typing a message and clicking a button. Here's how to
get the most from the Mail app.

This is the sidebar, which lets you select
mailboxes, see emails from VIP senders
or those which you've flagged, and more. You
can resize and even close this sidebar by
clicking and dragging the divider between this
and your emails list.

The list of emails contained in the
currently selected mailbox, in this case,
All Mailboxes. The number of emails in the
box, and the number of unread emails, are
shown. You can resize this column by clicking
and dragging its left or right edge.

Click this circular icon to toggle
between showing all emails and only
unread emails.

This button downloads new emails. You
can set your Mail app to check
automatically but this button does so manually.

When you want to write a new email
from scratch, click on this button to
open a blank one.

This button archives the selected
message. Very useful if you want to
make sure you don't delete it.

7 f you want to throw away the currently
selected emall, click here to send it to
the Trash folder.

This button moves the selected email to
your jJunk mail folder. Use it to help the
Mail app identify ‘'spam’, which is junk emails.

This button lets you reply to the
currently selected emall, with the reply
going to its sender only:.
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v 3 All Inboxes

£ Exchange

& Talktalk
1 7 &3 Pipex email 4
&2 iCloud 1
&4 Google

22 BT

> <7 All Sent 1
23 [3 Flagged 1

> [3 All Drafts

On My Mac

W Bin
v 55 0Old Papercut emails
B INBOX 1,258
B Archive

(55 Recovered Messages (iCl...

A3 Inbox

[Y Drafts
</ Sent

& Junk m

Bin
=] Archive

5 Conversation History

£ Inbox

Y Drafts

<7 Sent

= Junk
] Bin
= SavedIMs

&3 Inbox

[ Drafts

</ Sent 1

2 5 Checking for Mail...

All Inboxes

23 483 messages, o unread

® list-ITCorpSys@futur... In.. 3:31pm

Invoice for Purchase Order PFPL299901

ear lan Osborne Please find enclosed
opy of your invoice for purchase order P...

® Rob Mead-Green Inbox - Pip... 2:30pm

Future Publishing Ltd Brief - Secrets... 2()
Hi lan As promised - sorry for the delay ;)
Future Source Commission (publishing Bri...

eBay Inbox - Pipex emaill 3:21pm
Help us protect your account

Get a higher level of protection Hello lan,
It's been more than a year since you last u...

Nick & lan Sent - iCloud 3:18 pm
Is Rob away? 20
Hey Nick, |s Rob away at the moment? |

have a feature for him, and he hasn't yet p...

Nectar and British Air... In.. 3:05pm
Your Nectar points can take you further...

Convert your points into Avios to spend on
flights, upgrades, hotels and much more...

LinkedIn

Editor and Proof Reader VQ role at Pears...

Inbox - Pipex email 2:55pm

Your sKills seem to match this job Top job
picks for you Editor and Proof Reader VQ...

STM Goods Inbox - Pipex em... 11:39am
25% Off Sitewide Use Code: SCARY25 |...
The Scary Good 5Sale

support@mysugr.com nb... 10:57am
Weekly Report

You vs, Monster 0:7 Total score: 4 points
How can | earn points? Hey , this is how v...

Jo & lan Sent - iCloud 10:48am
E3 Finished article 3®
Great stuff, sorry for the lack of response

from us! -- Jo Membery Operations Editor...

MCV/DEVELOP Awar... In.. 10:02am

Don't forget to book your tickets!
IRL 2023 is getting closer and closer, book
a ticket now! DON'T FORGET TO BOOK Y..

Amazon.co.uk Inbox - Pipex... 7:04am

Kindle Daily Deal: Discover top eBooks fr...
[op deals for you Point Blanc (Alex Rider
Book 2) by Anthony Horowitz £3.49 £7.99...

Cavern Club Inbox - iCloud Yesterday
Re: A cloakroom

e Y

£ Nectar and British Airways
> Your Nectar points can take you fur

1o: lan Osborne,
Reply-To: Nectar




The two left-pointing Click the flag to mark This pull-down menu 17 These are emall
arrows here is the the currently open IS another way of iInboxes and as you
Reply Allicon. Use this button  email with a flag of this moving an email into another  can see, we have four email
to reply to the sender of the colour. Click the chevron next  mailbox or folder. accounts set up in Mail;
currently selected email, but to the flag for a pull-down however, you can have more
also to everyone else that menu that lets you select a Information about what or fewer If you prefer.
received it. different flag. mailbox the open email
IS In, what time it was received Your emails appear
The single arrow curling 13 Use this button to and the paper clip shows it here. Unread emails are
to the rightis the silence notifications has attachment. shown with a blue dot to the
Forward button. If you want to on threads that are sending left. Click on an email to open
forward an email to a third you too many alerts. The To search for a specific it in the main window.
party, that is, not the person emails still arrive, but they subject, person or word/
who sent it to you, use this. don't send notifications. phrase use the field here. If you have a picture of

the email’'s sender in
Contacts, it appears here. If
not, it's a grey circle with
initials. To the right is info about
who sent and received the
open email, and its subject.

open email and icons
from the toolbar are repeated.
They functionis the same.

m Hover over the top of the
nbox - Pipex email 3:05pm

ther ==

If the open email has
attachments, click here
for a pull-down listing them all.
You can select and open them.

If you've identified
senders as VIPs, they're
listed here. Click VIPs' to open
and close this section, and click
on a VIP name to see emails
from that person.

@ BRITISH AIRWAYS =*

As of 27th October 2023, you have 424 pts worth at least £2.12

23 Here you can access

emails you've flagged,
or those you have sent from
your email accounts.

Hey Mr Osborne,

Did you know, your Nectar points can be converted into Avios. Various other mailboxes
Avios can be spent on flights, upgrades, hotels, and more with assoclated with the
DULSE MEVC /52 accounts you've set up in Mail.

To convert your points, make sure you've linked your Nectar and

British Airways Executive Club accounts. When new emails are

downloading or

Why not scroll on and see where your Nectar points could take . .
you? sending, it says so here.

Find out more

The Column Layout

= T To use the old-school,

e = e column-based Iayout. in
the View menu, select
Use Column Layout.
Repeat this step to revert
to the modern layout.

" E¥F o = T ree g ey TaCy e el G e e | e e I N B il - = —
i Yy | T . . . - 1 g R ) L s ), ] i - N i N = I W 1] 'I-'_r
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Sending a New Emaill

_'I- P

5 u

o =

to let him know. Cheers, Nic...
9 Nectar and British Al
Your Nectar points c3

To: lan Osborne,
Reply-To: Nectar

3ritish Air... In... 3:05pm

oints can take you further...

yoints into Avios to spend on
les, hotels and much more...

, _ —_—
Inbox - Pipex email 2:55pm
of Reader VQ role at Pears...
m tn_ match this inh Tan inh /

1 Here we show you how to open a new, blank email, write a

message and send it to a given email address using the
Mac's Mail app. To open a new email, first click on the Compose
New Message icon in the toolbar on top of the window, the one
that looks like a pen writing on paper.

ese < -~ B~ & Aa

‘o James Gale~ Martin Smith
Lo Mark Ayshford - Alyssa Falcon ~

Subject: Things for Diﬂ-ﬂu‘jﬁlﬂd

From: lan Osbome — atskS4@ds|. pipex.com

3 It's always a good idea to put something in the subject

line, even if it's just 'Hello!'. Type the body of your
message in the large space below. An email can be as long
as you like and you can use different fonts, colours and sizes
If you really feel the need.

Customising Malil

d Malll FEs Edit  View Mallbox Message  Formatl  Window  Halp

(2]
Mow MEssagis sound:  Now Messagis Sound H
3 Pay sounds for othor mall actions

Dock unrsad count:  inbox Only 2]
2]

Mow messege notificathons:  Inbox Dy
Downloads folder: [ Downloads [

Hemove unedted downloads: After Mossage is Doleted H

Folkowe-Un Suggestions
Llail well remind wou about metsages (hal have

Archive of délete muted messsgos
Airtomatically try sandng Liter o cungong sarver |5 unavallable
) Srefer opening messages i Spit View when n full scroen

When ssarching all mallboxes, Include resuits frome

M Bin
Juink

Encrypled Massages

You can customise your Mail app by opening it and, in the
Mail pull-down menu, selecting Settings. Under the General
tab, you can set an interval to check for new messages,
decide where downloaded attachments go and more.
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Helvetica ¢ 122 ¢ JJJ & B I U S5 & = =
lo: James Gale ~

Cc: Mark Ayshford ~

gcce:
Subject:

From: lan Osborne - atsk94@dsl.pipex.com Sif

To send someone an emaill, type their email address into
the box marked To.. To also send it to someone else, adad
their email address in the Cc: box. Add multiple email addresses
in either box, separated by commas, to send the same message
to a group of people.

oee ¥ |- B~ & A @ @~

o James Gala= MMartin Smith ~

“t Mark Ayshiord - Alyssa Falcon~

iubject: Things for Discussion

rom:.  lan Osborne - atsk94@ds|. pipex.com nature:  MNone (2]

Hey Folks,
A few pointers regarding lomormow’s moeling with the shareholders, and a few things to discuss.

* Should the proposed lakeover go ahead?

* Can we afford to hire a new direcior, tasked with seeking acquisitions?
* Plans lor nexl year.

* Success slones from |ast year.

* Any other business.

Can anyone think of anything else lo add to this list?

Regards,
lan Osbome

Once you've finished typing your letter, click the Send
button in the top left corner of the email panel to send it
on its way. Email is usually sent very quickly, and your addressee
should receive it within a couple of minutes, as long as there are
no issues with their connection or provider.

Fonts & Colours

& @ W Aamﬁ&ﬁﬁ@

General Accounts Junk Maill Fonts & Colours Viewing ~Composing Signatures Extensions

Select...

Message list font: System Font Regular 14

Select...

Message font: Helvetica 14

Fixed-width font: Menlo Regular 11 Select...

Use fixed-width font for plain text messages
Colour quoted text

I Purple
B Teal
B Green

Level One

Laval Two

| Level Three

The Fonts & Colours tab lets you change the fonts and text
size used with incoming emails and change the colours of
quoted text. Explore the Mail settings and set up how you
choose, but be careful with the server settings.




Receiving Emaill

When you receive an email in your inbox, this is how
you open and read it using the macOS Mail app.

opecial crafts for special days

CNALTRMT U

Christmas Crafts

Once you've set up your email account, you can send and
receive email. As soon as you launch Mall, it connects to
your email service and collect any email that is waiting for
you. These messages are shown as a list in your Inbox.
Click on one and it's displayed on the right.

-
Il

X - ICloud Yesterday
ats @

P Our top picks for
se spooktacular ma...

While Mail is running, it periodically checks the server
for new messages. You can also prompt Mail to look at
the server immediately by clicking the button in the top
left of the screen that looks like an envelope.

Adding Attachments

Netflix
lan Osborne,
To: lan Osbq
Verified Logd

ight like

This message is f

Replying to & Forwarding Emaill

If someone you know sends you an email, you'll probably want
to reply to them. Simply click on the email so you are viewing the
text of it, then at the top of the screen you'll find a row of three
buttons, as you can see here.

The leftmost one has a single left-pointing arrow on it. This is

the Reply button. If you click on this you'll see a window pop
up that looks a lot like the window for a new email, but it will have the
responder's email address already in the To: box.

Next to the Reply button is a similar button with two left

arrows on it. This is the Reply All button; use this with
extreme care. If you have been sent an email that has also been
sent to a number of other recipients, hitting Reply All will send
your reply to everyone who received the original mail. Obviously
if your reply was meant to be private this is a very bad idea, and
has got many people into trouble.

The rightmost button of these three is the Forward button,

which is used to send an email you've received to another
recipient. Forwarding emails is another thing that requires care;
make sure that you don't accidentally send private information to
someone who was not meant to receive it.

Almost any type of file can be attached and sent over the Internet along with your email.

To add an attachment, first start an email (or reply to one
you received), and then click on the button bearing the
picture of a paperclip, at the top right of the email panel.
This will open a Finder window, allowing you to navigate to
the file or files that you want to send. Select the ones you
want, then click Choose File to attach them.

Pictures you've added as attachments are shown in the body
of the email. If you don't want to display it as an attachment,
right-click on it and from the contextual menu, choose View
as lcon. It can still be opened by the recipient. If your email
suggests you're sending an attachment but you forget to
add it, you get a reminder when you try to send the message.
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The Mail Markup Feature

o . oy
- - = -

.

The Markup feature lets you add notes and scribbles to
pictures that are attached to an email before you send it.
Write an email and attach it to the email. Click on the image, then
click the chevron in the upper right corner of the photo. Select the
Markup option to open the Mail app’'s Markup feature.

Message Size: 360 KB nage Size:  Large
Here's that piclure of the Williams family | promised you.
O~ B An » j h ] Cancal Done

L/

T
: . . N
. ﬁ“"‘ | iy

Now use the interface to add text, drawings, or a range
of shapes and symbols directly onto the photo, in the
email environment. When you're finished, click the Done button
and either mark up more pictures or send your email as
normal. You can also use certain third-party apps to edit
photos this way.

Remind Me

- ’ v i lan '
« CavernClub Inbox - iCloud Yesterday
B3 Re: A cloakroom
. Hi thanks lan - yes we have a cloakroom
| whara you chack Open Cavern Clib
Readly Send Again Re: A cloakroom
I Mo Tricks, Jus Reply Te: |a
Reply All
Ry ou ' Forward Hi thanks lan - yes we have a cloakroom where you check in tickets
= Netflix Forward as Attachment
1,258 Redirect Cheers
L1 lan Osborne T
i Remind Ma > Remind Me in 1 Hour
sages (iCl., : Remind Me Tonight )&
- Mark as Unread N ’ -
crmang & | SImOrTonw
magazine.co.u Mo to Jonk |
Today only - get : Remind Me Later..
Mute
Delete
Block Contact
Amazon.co.uk - , lan Osborne
Kindle Dailly Deal; o . & cloakroom
b N m N %
LE
Arch -
Nextdoor b Folks,
istory plovie Lo b
Sy Mew from Karen i ) _
Copy to » Do you have a cloakroom where | can leave my coat during a gig? The first (and so far, only)
y Conflict gig in July, so getting rid of a heavy coat wasn't an issue. I'm going to Chaotic Discos
Apply Rules encumberad with an overcoat.
Readly . 10fZ0L: Great venue, by the way. | really enjoyed the Conflict show, and will be back for more going |
2 New issues of your favourite magazi...
Regards,
.. |-Eg -

If an important email arrives but you don't have time to reply,
use Remind Me to select a date and time for it to jog your
memory. Right-click the email in the middle column, and select
Remind Me. You can be reminded in an hour, tonight, tomorrow
or ‘later’, which lets you set a custom time and date.
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Move to...

Highlight or open an email. In the top-right corner
there's a pull-down menu showing a folder icon in the
toolbar. If your Mail window is small, you might have to
click on a chevron and select it from a menu. This lets
you move it to one of your folders including Trash,
Junk, and folders you've set up yourself.

MOV DEVELDP Avar

Show Only Unread Messages

You can hide emails you've already read by clicking this
icon. Now only unread messages are shown. Click it again
to show all your emails once more. It's great for finding
emails that you received a while ago but haven't seen yet.

All Inboxes

i . I & ml ¥
{ e &Y, I I = T
1 . i et L= i d “

® Netflix

T0

® MyHeritage DNA Mat...
lan Osborne, you've got DNA M3

Having problems reading this ema

N st 13 B et a ram  lam Tamas] asitaranl |
N vour prowser. Hi lan. Good news
|| N Y Nl | - N N e | |} - i L W W - I 1 WY e X
s

Flagging an Emaill

To mark an email with a flag, highlighting it for later
reference, click on the Flag pull-down and choose a colour.
You can add more than one flag to a single email. To
remove them again, choose Clear Flag. The ‘Flagged’
option in the side bar shows emails you've marked.

Orange
an Osborne, we've just added a docuseries you might like M Purple

. Blue
70 Learn More Yellow

™ Green

is message is from a mailing list. Ra' Mot
c. v

Clear Flag
N For lan Osborne Toggle Flag




Mail Drop

If you need to send large attachments via email,
the Mail Drop feature is very useful.

Would you like to send this

_ . attachment using Mail Drop?
lestapp.iso
This attachment may be too large to
send in email. Mail Drop can deliver a

large attachment using iCloud. It will be
available for the next 30 days.

Use Mail Drop

Try Sending in Email

Cancel

Don’t ask again for this account

If an attachment you wish to email is too large for a
regular email, it's stored on Apple’s server and offered
as a download instead. Depending on whether the
recipient is using Mail, the attachment could appear
as a download link or as thumbnails.

”‘ Save All [1.04 GBE
5% - in the City 4.jpg
- On the Beach 03.jpg .
- Coronavirus 4.jpg |
- On the Beach O4.jpg
® - On the Beach 05 jpg
- Rock Festival 02.jpg
- Rock Festival 12.jpg
- Rock Fastival 06.jpg
Coronavirus 3.jpg
in the Woods 3.jpg
. - Family Meal 06.jpg
W] - Family Meal 12 jpa
' On the Beach 13.jpg

Here, we received huge photos, which are displayed as
thumbnails. You can download them all by hovering over the
email and clicking on the paperclip as shown. They're kept
on Apple’'s server for a month from the date they were sent.

Scheduling Emails

Mail 1)

Searching Your Emails

= e

(.
Q. Pictures [

(), pictures archive
L slnl.l_:-'..l.|” 2 NS
(&) Sender contains: Pictures

<0 Subject contains: Pictures

2 Attachment name contains: Pictures

Click the magnifying glass icon and type your search term
Into the search field. Suggestions are offered for items
such as people, subjects and attachments; emails that meet
your search requirements are shown in the email list.

'3 i,
-
Q Pictures (X
v Subject
Message
. >

After clicking on one of the suggested items, you can
adjust your search by clicking the first word in the field
and choosing a new option, as shown here, or even adding a
second search term for more advanced searches.

In Sonoma, you can schedule when your pre-prepared emails are sent, choosing a date and time.

it ™

7 () ®-

Send Now
Send 9:00 pm Tonight
Send 8:00am Tomorrow

alvetica ° 14
0: James Gale v

Cc: Send Later...
Subject: Look this up

From: lan Osborne — atsk94@dsl.pipex.com

You can now prepare an email now, but send it some time
in the future. First write the email in the usual way, and
then click the small, down-pointing chevron between the
Send and To Fields buttons as shown.

' B}
Send Later
L This message will be delivered by this device at the
4@dsl.pipex.com time you choose. Make sure this device is online to
ensure message delivery.
£l 10/2023 2 5:41pm o
Oct 2023 4 0 »
: ] '_'.I,I -.-:. -Il.._n__ _I 1 _:-I .'.__-: '-:-.': 12 - :
you look at this artic . 11 1 iey might differ from
' ' 10 s
)ure looking for. T e TR
9 10 11 12 13 14 15 9 :
16 17 18 19 20 21 22 | 4
23 24 25 26 27 28 29 W
30 31
= oy

Choose to send the email in an hour, tonight, tomorrow or
‘later’. Choose this last option and you get a window in which
you can set a custom date and time. Use the buttons, or click
on a number and type over it. When finished, click Schedule.
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Using Mail Signatures

You can add a signature to your emails, that is, a short
piece of text that's at the foot of every email you send.

ﬂ Atways match my default meseage fort
rutc i i

Place signature above quoted text

A signature is a piece of text that you can add to the foot
of your email automatically. To set one or more up, open
Mail Preferences (from the Mail menu), click on Signatures
in the top bar and then on the account to which you wish
to add a signature in the accounts on the left. Click on the
'+’ button under the middle column to add a signature.

lon Osborme - atikBd@del pipex.com

You can click on the name of it in the middle column and
change it to anything you like, and write your chosen
signature in the right-hand column. It can be anything
you want. Now, when writing, forwarding, or replying to
an email, you can add or remove your signature using the

pull-down menu to the right of the From field.

Accessing Emojis

W wowe W
W

O a&GRvOPRP»

The Mail app has an emoji picker to use when writing an
email. Click on the smiley face in the toolbar and you get
a choice of emoji to add to your email. To add it, just click
on the one you want. Scroll up and down, or click the
icons at the bottom for more choices.
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Unsend an Emaill

Ever sent an email and spotted a mistake In it just as you
pressed Send? You can now recall it, if you're quick.

Mal FEe EQR UVIiEWTE Manbox | Message Formal Window  Hep

® ® All Inboxeg F oY = H_',ai
L3480 messaces st — i

MNetflix box - iCloud 5:07
lan Osborne, we've just added a doc...

Netflix

lan Osborne, we've just added a docuserie
oed Trom DOth sades of the law, this Te: lan Osborng

locuseries from the makers of "Faar City Verdied Logo Learn More

MyHeritage DNA Mat... ag

lan Osborme, you've got DNA Matchas! (.

Having problems reading this emal? Vies

O This message is from a mailirg Est

list-ITCorpSys@futur... | M p
Invoice for Purchase Order PFPL223901
 TOF purchase orger ..
Rob Mead-Green nbox - Pip 3:30pm
K3 Future Publishing Lid Brief - Sec... 23
i o ¥ m 'r i Tied | ."".t 'l.._j_' 3Py

eBay nbox - Pipex amail 3:21pm 4

1 First of all, make sure you have the sidebar open. The

sidebar is the one on the left, next to the incoming emails
list. If it's not there, select Show Sidebar in the View menu, or
press ctrl-cmd-S. The sidebar will then appear.

= B 25% Off Site\

< Sent The Scary Go
= Junk

i Bin support@m

Weekly Repoi

i You vs. Mons

® Undo Send How can | ear

When you send the emall, a link labelled ‘Undo Send’
appears at the foot of the sidebar. You have ten seconds
to click this link; when you do, the emaill reappears so you can
edit it. If it's not therg, it's too late to recall.

Unsubscribe

>4 E B @ QA <A & . . J& £33 Move to... (

Microsoft Store B3 Inbox - Pipex  9:44

Be in with a chance of winning £125 to spend at Microsoft Store

To: lan Osborne

=" Microsoft

c W ¥

If an incoming email is from a mailing list, the Unsubscribe link now
appears right at the top of the email. Click the Unsubscribe link to
stop this mailing list from sending you emails in the future.



j Mail and Home App

Home
Forthe Smart Home

Apple's HomeKit gave developers the means to control compatible household
gadgets from devices such as the Mac, iPhone, IPad and iPod touch. Your

connected home gear can be controlled under one application. You can set up
automations too, so multiple devices can be activated with a single instruction.

Discover Home '
Explore the possibilities and see how easy it is to add ¥ Eve Light Strip D976 x

BN 10 JOnk Icrme. This accessory is unavailable. To control it when you're away from

home, set up a home hub.

This accessory is unavailable. To control it when you're away from home, set up
a home hub.

Eve Light Strip D976

Room

Add 1o Home View

1 Before you can make use of the Home app, you have to After adding some devices using your iOS device, you
add HomeKit compatible devices. You can only do this can access them through Home on the Mac. Right-click

from an i0S device, you can't use your Mac. There's a list of a device's window and click the cog (bottom-right) for the

HomeKit compatible devices online at www.apple.co/2MFjhb3. Settings, and you can change the room they're assigned to.

— _‘I

3 Click Automation in the sidebar and you can set timers, For example, you can use the Home app to control and

actions and more. What they do depends on what kit you've configure speakers that are compatible with HomeK:it.
incorporated into your Home app. Click the + icon to add Naturally, Apple’'s own HomePod, pictured here, fits the bill but
automations or groups of automations (scenes). there are plenty more.
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Music
Play Your [unes

The Music app Is great for enjoying all your sounds on the Mac. If you
subscribe to the Apple Music service, you can stream from over 90 million
tracks and numerous online radio stations. You can rip your CDs and store
them on your Mac, and you can also compile your own playlists.

Little has changed in the

macOS Sonoma Music app, but
collaborative playlists have been
introduced - invite each other to
select and edit tracks, and add
emoji reactions to specific songs.

When you're using the Music
app, the top bar gives you
pull-down menus offering controls and
options. It's worthwhile familiarising
yourself with them.

Completion suggestions are
offered as you type, and results
can be limited to Apple Music, or your
on-Mac library, as you wish. Results
iInclude artists, songs, albums and more.

These are, in turn, Shuffle Tracks,
Previous track, Play/Pause, Next
track, Repeat Play.

When you're playing music, the
album art, artist and title are
shown here. Click on the album art to
switch to the mini player, which shows
the aloum art and controls only and
takes up much less space on the
screen. The line under the track name
lets you scrub through the sonag.

Click and drag the dot, and move it
left and right to change the volume.

These three icons, in turn are;
wirelessly transmit your music to
Bluetooth headphones or speakers;
open a sidebar showing the lyrics to
the track that's currently playing; show
a sidebar giving both a list of what's
playing next and your history; that is,
what you've played.
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@ Music Fie Edit Song View Controls Account Window Help

(» Listen Now
B8 Browse

(-9 Radio

Library w

(@) Recently Added
& Artists

() Albums
J Songs

Music Videos

Store

vz iTunes Store

328 All Playlists
& 90's Music
{5} Classical Music
{&) Music Videos
&% My Top Rated
{5 Recently Added

5 Recently Played

&} Top 25 Most Played

=] Alanis Morissette Esse

=I" Alison's music

=" Apple Watch

=I' Classical and Jazz

=/ Extreme Metal

=] Female vocal

=I' From iPad

=/ lan's Music

=" Motley Criie Essentials

=] Municipal Waste Essentials

= My Shazam Tracks

=] Playlist

=/ Regina Spektor Essentials

=/ Soft Songs
=] Untitled Playlist

e W i e . B it T i, -l il v 0 ol e - " e B e . e e e il i ] e w S -

3

Listen Now B
Top Picks
Featuring The Rolling Stones Made for You Featuring Sn

b <58

& Music

Favourite
MiX

THE ROLLING
STONES

The Hackney Diamonds Special
Keith Richards joins Matt to talk The Rolling Stones’
new album

Amon Amarth, Metallica, Black Sabbath, Arch Enemy,
Motbrhead, Slipknot, Megadeth, Métley Crie, Celtic
Frost, Carcass, Municipal Waste, Slayer

Recently Played >

J O H N MR S '80s Hits

:yales L':]_ HQove and Y

The Best of Johnny Cash '80s Hits Station Tales Of Love And Loss (Remaste:
hnny |:__.|_:::" Vel s AT it hAMadisavual RBaalac

1980s
CONFLICE

MacBook Pr




Importing Your CDs into Music

< 44 Pp M O g_"

The Very Best Of The Doors

= o Tole Timg Arcst

1 « Broak On Theough [To The Dibsr Side) 27 The Dioors
2 « Light Ny Fire 058 The Dooes
3 « Love bis Two Times 398 The Doors
i + [olka, | Lowo You 2:42 The Doore
B « Paople Are Strange 713 The Dinom
B + Strange Days 309 The Doors

< Hiders On The Storm 709 The Doors
B

# LA Woman 800 The Door
B o ek Lla 1099 Vi Phiun !

1 Insert the CD into your Mac's CD drive if E You see the track listing of the album , Once you've successfully

it has one. If not, use an external optical appear. The spinning circle indicates imported your album, don't
drive like Apple's USB SuperDrive. Amessage  which track is currently being copied, while  forget to click on the Eject button in
pops up asking you if you want to import the a green tick next to a track tells you it has the sidebar or the top-right so you
album into your iTunes library; click Yes. already been copied successfully. can store your CD away.

® Q 9 ) & = Tue31O0ct 11:58am

f you have an Apple Music
account, Listen Now is the main
page, offering suggestions of music you
might like and showing what you played
‘ecently. Browse is great for finding new
music, and Radio gives access to
streaming stations.

7

Folsom Prison Blues

Zash — The Best of Johnny Cash

This is the Listen Now page, your
gateway to the Apple Music
streaming service.

wokey Robinson Made for You Featuring Sammy Davis, Jr

& Music -- W | # Music
Click here for your profile, and also
the Apple Music social network
where you can find out what sounds your
friends are listening to, and discover and
enjoy new music together.

These are the options for your
Library, that is, music you've
installed on your Mac. It can be arrangead
into Artists, Albums, or Songs, and there
are sections for music you've recently

added and music videos.

ey Robinson & Similar Artists lan Osborne's Station Sammy Davis, Jr. & Similar Artists

At the top of the Listen Now page

IS Top Picks, a series of playlists made
up of tracks chosen for you based on
previous plays, tunes you play a lot, themed
playlists, etc. Scroll left and right for more.

Humphrey Lyttélton

These are your playlists. The top
ones are Smart Playlists, which
add songs automatically according to
rules, and the lower ones are playlists
you build yourself.

Black Sabbath The Beatles Humphrey Lyttelton

m his is a round-up of music you've

recently streamed. Scroll this page
up for more suggestions, again based on
previous listens.

Hover over the row and click the
chevron for more music options.
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Signing Up for Apple Music

Listen Now

© meatow Listen Now

Lose yourself in millons of songs.
Lase yourself in millions of songs.

Get 1 month of free music

Fius your eriiee must Ebeary on M your devcea. 1 manth free, 1feen
4 ] ]

1 With an Apple Music account, you can stream from 90 A pop-up window appears inviting you to subscribe as an
million songs for a set monthly fee. To sign up for an account, individual, for £10.99/$10.99/10.99 € after your free trial.
click on Listen Now in the left-hand sidebar. You can then click Try it Click Try it For Free to do so, or See All Plans to choose a Family
For Free to learn about and sign up to the service. or Student account

Lose yourself in millions of songs. Lose yourself in millions of sangs.

X X

| Please enter the verification code sent to your iPhone.
Sign in with your Apple ID I i —

Skgn in to Apple Media Services wath your Apple 1D, Don’l have an
Appla ID? You can create one lof Trea.

Apple 1D: I To protect access 1o your account, your Apple 1D can
: only be used from devices that you approve.
Learn more...

Forgot Apple ID or Password? "
- Did not gat a verification code?

Cancel

R sy et i b ot i B et L e o e i e S e
Plus your entire music library on all your devices. 1 month free, then Plus your entire music library on all your devices. 1 month free, then
£8.99/month. £9.99/month.
See More Plans Saa More Plans

Already a subscriber? Already a subscriber?

2 You must then sign using to your Apple |ID. Enter your If you have other Apple devices logged into the same

Apple ID's email address, then your password, and then Apple ID, you're sent a verification code. Enter it, then
click Sign In to proceed to the next step. If you've forgotten follow the on-screen instructions regarding what kind of music
your detalls, click the Forgot Apple ID or Password? link. you like. When done, you're ready to start.

Changing or Cancelling Your Subscription

1 If you want to cancel your Apple Music subscription, first You're shown your active subscriptions. Click on Apple

of all, click Account in the top bar and select Account Music's or Apple One's Edit link. On the next page, you
Settings. You're taken to your account page. Scroll down to can change your subscription to a different one (individual, family
Subscriptions (under Settings) and click the Manage link. or yearly, Apple One or just Music) or cancel it altogether.
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Using Apple Music

"

Bad Magic: Seriously Bad Magic O
Motorhead

Bad Magic
Motorhead

METAL - 2015 - T Los

v Added

Browse or search for the artist, album, or track to which you Music controls such as Play and Pause are found at the top of

1 want to listen. Here we're looking at an album. Click Play to the window. To identify tracks on an album you especially like,
play it in its entirety, or Shuffle to play the tracks in a random order. hover the pointer to the left of a track, and click the heart that
racks marked with an 'E'in a box have explicit lyrics. appears. To cancel this, click on the heart a second time.

wotorbeas

Bad Magic: Seriously Bad Magic B
Motorhead

-

-
L

3 Click the three-dots icon on the right above the tracks for Each individual song also has a three-dots icon, offering a

a menu. Here you can add the album to a playlist or create similar menu that applies to that track alone. You can also
a new one, share it with your friends, like or dislike the albumasa  play the track by clicking the Play icon that appears when you
whole, or create a station based on its artist. hover the mouse/trackpad pointer over it.

Pl W B L
1989 (Taylor's Version] [Deluxe]
Taryiar Swift

Apple Music is all about helping you to find music you enjoy The Browse section offers tracks, artists, aloums, and
listening to. When viewing an album, you can scroll up and playlists based on Apple Music editors’ choices and new
other titles by the artist in question are shown. Click on one to releases. It also offers current charts for various countries. The
open it in the main window, click the chevron to see more. Radio section lets you listen by station or genre, and more.
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Q NeV\.lS
» 9 Stories and Features

The News app Is great for getting the important headlines as they break,
from news sources around the world. If you subscribe to Apple News+ you
can read a huge range of magazines and news publications on your Mac,
and you can even fill in crosswords on your screen. Here's how it works.

BEAE NEWS

€News m - _ .
31October = v Squirrel hops on board train in
. o v T R Grays and takes seat
b Sharnd whh Wi Top Stories [ . 71

 TH
A Saved finaries & 4

[ 1. S

Boris Johnson had *wrong skill set’ to lead during
Covid, top aide tells inquiry

Sogusrred Rasod oo Beoard tra o Grays ard Takes seat

Video captured the momenis a squirnel boarded a trasn and took a seat alongiide other
Pas eI

Thee pectusnes, Slmed by Kim Smith, were taken on 5 .c2¢ serdce between Grays and
Pusrfliset in Eqsax on Manday bunahtins

Sk aald “The squirrel hopped on st Grays jusl & the doort cloted. | often takee the b
BUt ol el Sl rrythinag Likoe this Desfoere.”

Th sqquirred |89 the train safely soon it

Discover more

Loy M
Wiir STarmas bings Harmay s ba wmboidaned’ by birsel-Gaza cosielivn Plans 10 clows rad ticamt oMoy o Frglend serageed

When you open a news story, If it has a video it can be

1 When you first open the News app, you see a sidebar and
watched within the News app. In the File menu, there's an

a main window. The sidebar’s Today option is selected,

giving you a range of the day’'s top stories. Click on a story to option to open the story in Safari. This takes you to the web page
open itand read it in full. from which the story was drawn.
==
0 roinics
B eoie vows spotig
3 Shared with You #News Special Coverage L

Talking Points

% i T
A Weird Asteroid Is Orbiting Earth—and Scientists reveal how to understand
it's Actually a Chunk of the Moon what your cat is trying to say

(RTE 0, WA
s5ins
n
n
B S s - 1 e
A myateriows lorce wnder Schentisls pevesl Exsctly
Antarctica is changing how == —— whal killed the dinosaurs -
i e e - wrd it"s still sround today
-
et -

Sclentific breakthrough

could helg explain why
Uranus is 5o hot

Why Big 0il is back - and what it means for net zero Scientists urge WHO to declare health emergency

for planet

Eriler Laimmen)

M=

Hew SOt

The trees in our crties are dying. A sick microbsome may
be to bilama.

How climate change s affecting the way we have bables 1§

Latest Stories

[ s T B
- - ] ¥ ; # - f
4 L : e
- e e -
L .ﬁ" ; = - i - =

3 The Special Coverage section gives you a selection of In the sidebar section titled 'Suggested by Sirl', you see

features chosen by Apple's editors. If you find a story you various subjects the News app thinks might interest you.
particularly like or dislike, use the thumbs up/down icons in the The stories work just like in the other sections; click one to open
top-right corner to improve future suggestions. it, click the chevron in the top-left to go back a page.
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Solar panel farms in space
could give boundless clean
energy supply say scientists

A research team from UK wniversities say hndings could previde broakthrough for cloan energy

Hally Hakr Toraday 1 Orinbe ) 133

For the fir :, scientis ythnha ¢ proven that gigantic =
Ih: e, Jn,“ a pote u]l'!.l upply of clean energy

A team, fro ity of 5

and University of Swansea, follo a satellite in orbit for
&I% YEars in n-rd-r.'r Lo :.ll:ls-rn't I-"lr.l-w lhr.' pancls generated power, wulh:rl:d solar radiation an
tolerated space's harsh conditions,

In the File menu is an option called Discover Channels.
Click it for a range of news sources and subjects for you
to choose from. Select this option for a window showing news
sources you might like to follow.

7 Enter a search term for a subject or source you're interested
in for a list of relevant stories and channels. Click the plus
sign to add that channel or topic to your sidebar. To remove a
channel or topic, right-click on it and then select Unfollow.

My Sports

Click on the Sport option found near the top of the
sidebar for a section dedicated to (you guessed it)
sports. Click Get Started and you can choose teams
and categories you wish to to follow in the News app.

—
Y

il Sporriy, |l.

My Sports
000000
Top Stories

Solar panel farms in space
could give boundless clean
~ 1StS

Discover Channels |

| for clean erergy

|
Suggested For You
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For the first tme, scientists say the yhn ¢ proven th lg:lg.mln; ar farms in space are possi-
hlmnjngp-u atlally baundless supply of clea

A team, from University of Surrey and Unlversity of Swansea, followed a satellite in orbit for
slx years in order 1o observe how the panels generated power, weathered solar radiation and
toleraled space’s harsh conditions.

EECBEL

Scroll down the window for more channels and topics.
Select as many or as few as you like. When you're finished,
click the Done link in the top-right corner. Your new sources have
been added to your sidebar.

O INDEPENDENT h P ¢

Apple MacBook Pro: New
laptops revealed with new
chips - and new colour

MNew generation of chips and "space black' colour revealed &1 “Scary Fast” svent dlongiide updated
iMac

Anairws GriMe Torsdiy ) O tobspr D023 | 708

-

To save a story for later reading, select Save Story in the
File menu. Click Saved Stories in the sidebar to see the
pages you've saved. To go back to a story you've previously
read, click the History option in the sidebar.

Apple has revealed an updated version of its MacBook Pro, feataring new chips and a new

Shared with You

You can share News articles using the macQOS Share icon.
If someone shares a story with you using Messages, it
appears in a sidebar category called Shared with You. The
person who shared it is indicated under each story.

Silent Hill: Ascension is Hidden button on plane
a streaming show with seats that will make
the frills of a multiplayer your journey comfier

game

BuzzFesd UK

Wy From James >

AFM: Leonardo
DiCaprio's All-Star
Animated Feature 'Ozi:
Voice of the Forest'

Sells to Signature for U.....

W Fiom James

DOE HEwWS

Squirrel hops on board
train in Grays and takes
seat

W From James o

FErTy

‘Godzilla Minus Ona'
Sets Pan-Europe
Theatrical Releases

Through Pieces of Magic

(EXCLUSIVE)

W From James

v NEWS

Flood and rain warnings
issued as weather
builds to "nasty storm’
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macOS Sonoma's Key Apps

Photos
* Manage Your Images

The Photos app gains a couple of new
features in macOS Sonoma. The People
album can now recognise your pets as

well as fellow humans, and Visual Lookup
recognises food and gives you recipes, and
can work on video stills as well as photos. N e

‘) Memories

@ People

J, Places

Rotate the image 90%
anti-clockwise. Hold Alt to turn
It clockwise instead. Useful if a
picture that's been imported is not
the right way up.

Use this button to toggle
between regular thumbnails of
your photos, as seen here, and
square-shaped images that leave
little border.

) Favourites

@) Recents

4] Imports

() Duplicates

[l] Recently Deleted

Albums

1 4 > ] Media Types

> &) Shared Albums

1 6 > ) My Albums
1 7 > rjMy Projects

E his slider increases and B ne search field. Thanks to the
decreases the size of your Photo app’'s machine learning,
preview images. you can search for terms like ‘birthday/,

holiday’, '‘Christmas’ and more, to find
Use these buttons to view your  photos taken on these occasions.

photos arranged according to
the year, month, or day in which they
were taken.

Click here to see all your

arranged as thumbnails. Double-click
on a thumbnail to open a photo, filling
the application window.

Select or open a photo and
then click the 1" for the
information window. Here you can
review and edit where and when it
was taken, add captions and more.

The Share button lets you add
the picture to shared albums,
send it using Mail, AirDrop, Messages
and more, add it to Notes or Reminders
and even set a desktop picture.

7 Choose a photo and click the
heart to identify a picture as
one of your favourites.
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photographs in the Photos app,

Filter to display all pictures,
favourites, those you've edited,
only photos, only videos and
according to keywords.

These sidebar options
represent different ways of
viewing photos found in your library.
Photos shows all your photos,

Memories arranges them into groups,

Favourites shows your best pics, and
Places groups them according to
where they were taken. Recents,
Imports and Recently Deleted are
self-explanatory.

These are the dates between
which the currently visible
pictures were taken and the locations.

The heart seen in the corner
here shows you've identified
this photo as a favourite. Click the
heart to unfavourite it again.

e CE————————————




Click here to arrange
and view your media
according to type, such as
Videos, Selfies, Live Photos,
Screenshots and more,
depending on what media you
have in your Photos app. This
doesn't remove them from the
main Library; it's simply a way
of arranging its contents so

you can better find your media.

3

Years

Click the chevron to
expand the Shared
Albums category. Photos
you've shared on iCloud are
listed in Activity, and Shared
Albums shows the albums in
which they were shared.
Hover over Shared Albums
and click the plus sign that
appears to the right to start a
new, shared album.

il

Months Days All Photos

99 Photos

Syncing Paused for 26 ltems

Optimising System Performance -

Sync Now

MacBook
k. =

These are your albums,
whether created by
yourself or put together
automatically by the app. Click
Shared Albums then the plus
sign to open a new one, which

you can then share with others.

17 Projects is for creating
photo books and more
using third-party apps.

o '6 O |8

fI’]ODCL

Your pictures, arranged
as thumbnails. Click on
one to open it, after which you
can swipe through them or
choose one from the preview
bar under an open photo.

At the foot of the screen
you're shown how many
photos and videos you have in
the currently selected album.

Filter By: All ltems v 1 0
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The Editing Tools Edit With

Right-click on an open photo and you get a
sub-menu. Hover over Edit With and, if you have
third-party photo editors on your Mac, you can open
the photo in one of them and then edit it using that
app. Edits are carried over into the Photos app.

W Coborfync Uity

& Dfesed

I Cul FlmPack &
B 00 vanPoe 4
B OO Prsisias 8

1 Open a photo and click Edit. Use the Wand tool to
automatically enhance your pic or click the Edit button to

make manual adjustments. In Editing Mode, the Edit button

changes to ‘Done’. Click this when you've finished your edits.

Click a triangle in the sidebar to open a tool. The Light, 5 Retouch removes unwanted objects from a picture.
Colour and Black & White tools give you sliders to Click the brush, then click and drag to paint over the
increase or reduce the brightness and saturation or switch to object. Let go and it's removed. Red Eye lets you paint out
a monochrome image. Click the Options triangles for more red pupils caused by camera flash. You can adjust the brush
advanced editing tools. size with both tools.

. %
L' N

o : ) ] S o
1 '.'.‘ : " - = g 3
WL R ' e
o o X .
N -
e ‘\ . -
1 . —

In White Balance, select the feature to adjust with the In Curves, drag the diagonal line or the dots under the
pull-down and use the slider to change it. Levels take time right and left ends. A useful trick is to click on the left

to master. Hover your pointer over the graph and drag the dots dropper and click something black, then the right dropper and
at the foot of the vertical lines to adjust. click on something white. The Definition tool is another slider.
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Selective Colour and Noise Reduction are sliders. The
former lets you make adjustments to one colour at a time,
using the pickers and sliders and Noise Reduction is for smoothing
out speckles and other such imperfections in the photo.

> V| White Balance

Lurves

I
M e LEVEIS

s+ Selective Colour
F | Noise Reduction
- A Sharpen
Intensity
Edges

Falloft

Vignette

-3 =
i
i = o - A - - - - L
3 X 3 3 - "
. al - -
5. % 2 | } =] = = =
W 5 a 5
4 il 1] 2 — 3
" = 3 = - [T}

L
I1zﬂ-:':-"-

Select the Filters tab and you can automatically add an
effect to your photo. Here we've gone for Vivid Warm
but you can also set it cooler, make it monotone and more.
Choosing another filter overrides the last one. Choose
Original to remove all filters.

-

Hue

Saturation

Luminance

Range

> B Noise Reduction

Vignette

Reset Adjustments

Edits made in the Photos app are non-destructive, so your

Adjustments in the bottom right corner to reverse the last edit, or
Revert to Original in the top left to erase all the edits.

edits can be reversed. If you don't like your edits, click Reset

7 The Sharpen tool lets you sharpen pictures that are out of
focus. You can sharpen the edges, adjust the intensity and

more. The Vignette option lets you add an adjustable shadow to

the edges of the photograph, as you can see we've done here.

You can the Crop tab to rotate your photo if it isn't
looking straight and also to crop it by dragging the
corners into the photo. The Flip option in the sidebar mirrors
the pic and Aspect lets you resize the photo according to an
aspect ratio of your choice.

Universal Tools

All the options in Edit Mode have these three tools,
which appear when you hover over or open one of
the settings tools. The curly arrow reverses the last
adjustment you made. Auto makes an automatic
enhancement with that tool only and the tick in a
circle toggles the last edit you did on and off, so you
can see the difference it has made.
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Projects

Wil Taunton 4-8-12

=3 The Birds, Feb 2007
8 The Gadget Show 2...
B Vvisit to Aldridge, De...
e Weymouth, Aug 2011
% with Jon and Family
# xmas 2006

&l Xmas 2007

B8 xXmas Meal 2003

@ York, August 2006

Projects
v [] My Projects

Choose the pictures you want to use (hold cmd and click on
them one by one), then click '+ next to Projects and select one.
f no apps are listed here, choose App Store and download one.
Jsing your chosen app, follow the on-screen instructions to
create a project like prints, cards, books and calendars.

Adding People or Pets

1 Open a photo with people in and click the " icon for the

information window. Click one of the faces shown in this
window. The face is circled, and you can add a name. Faces that
are recognised are already tagged. Click the Plus sign again to
add further tags, which you can drag into place as needed.

Memories

E Recently Deleted m

v ] Media Types
¥ Videos
2 Selfies
@ Live Photos
(#) Portrait

1 Click on Memories in the sidebar to show photos

content. For example, a series of pictures taken over a week in
a certain location might be identified as a holiday. Photos also
picks your best shots too.
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grouped according to various factors, including time and

Copy & Paste Edits

Capr P

If you have a series of photos you wish to edit in the same

way, you can now copy these edits and apply them to the

next picture. After making your edits, right-click on the picture

and choose Copy Edits. Then open the next photograph you
wish to edit, and then right-click and select Paste Edits.

Click 'People & Pets' in the sidebar to see photos you've
identified by name. Click on a person to see all the
photos you have of them. If a photo doesn't contain that
person, right-click on it and select the option ‘X is not in this
photo’ to remove it. Scroll down and click Confirm Additional
Photos to check pics the app thinks are of that person.

Arounsthe |

Tabyp ith
AliSPHF

OVER THEIYEARE

Right-click on a memory and you can delete it or add it
to your favourites. Open a memory and hover over the
picture at the top to see a Play/Pause button. Hover over the

slideshow for more controls. Click the Music icon to change
the background music.



Making New Albums

rf

) Imports
[0) Duplicates

] Recently Deleted

Albums

> () Media Types

> 4 Shared Albums
> (] My Albums

Projects

v (] My Projects

Album

{3 Smart Album
(3 Folder

] ] " A
_______

Q

Open a photo and click on the T icon in the top bar to open the
information window. You can add a title, caption, key words and
more here. You can also click on the date and time that it was

taken to open a second window.

1 Cmd-click the pictures you want to make into an album,
then hover over My Albums in the sidebar. Click the plus
sign and choose whether to make a regular album, a smart
bum or a folder. If you choose a smart album, you can set the
album’s rules to anything you like.

Editing Photo Information

Merge Duplicates

If you have a lot of duplicate photographs in your
Photos app, there's an easy way to merge them. In the
sidebar, select Duplicates. All your duplicated pics are
shown. To merge them, simply click on the link ‘Merge
X ltems’ above each collection of duplicated pics. Do

this on a per-picture basis.

. Smart Album Name: | Untitled Smart Album

Match the following condition;

1 tem matched

Photo ] wouite ]

. slo-mo

hidden
edited
RAW
ProRes
HDR

video

selfie

Live Photo
portrait

long exposure
panorama
time-lapse

Cinematic

burst

screenshot
screen recording
animated

B Set its title in this window too. In the future, all photos

that meet the rules will automatically be added. The new

album appears in your sidebar; click the triangle next to My
Albums to see them all. You can drag photos onto a new album

to add them to that album.

Visual Lookup

Eﬂ

If your photo contains landmarks, art, plants, flowers, pets, food
and more, the information icon turns into a Visual Lookup icon.
Click on it and icons appear on the objects in the photo. Click
one of these for information on what it is.

Deleted & Hidden Photos

To delete or hide a photo, right-click on it and select the
option you want. The Recently Deleted album is in the
sidebar. In the View menu, choose Show Hidden Photos
Album to add this one. Click on one of them, and you can
open it with your password or biometrics. Right-click
one for options to unhide or recover it.

" Recently Deleted

Touch 1D or Enter Your Password to View This Album

Virw ADuim
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Contacts
Your Address Book

Contacts is your digital address book, in which you can store details for
friends, family, workmates, professional associates and more. You can add
addresses, telephone numbers, social media accounts and other such
Information, and store your contacts in user-defined categories.

Managing and Maintaining Contacts

i N

S

1 This guide shows you to how to add new contacts to

your Contacts address book, edit existing ones and
share a completed contact card with other people. To create a
new contact card, click on the plus button in the bottom left of
the current card. Select New Contact from the window that
POPS up and you're given a blank card to fill in.

Cancel

RN COMEETS T i 1 L) " A
Cloud
- . Memall
All iCloud = Memoaji
» Aldnoge Sch e Emoiji
o BHRONE FIMIND
7 Monogram ——
XY EEK.
« For Frealance @ Camera ey ) y
nsF (& Photos -~ —
g . OUVRTY 2
1 Suggestions 2 < —_— s i
» Dde K Enas |
o Oinhwg Chommi -
iy - | | \
4] tnininal Cor @ W N ¥ .
» Hiotho College ‘
« Rolle Calisge - - A i
o - £ f  §
. Work & Ex ) & & &9
O has |
Al o My M I W f : o0
8 @
”' D99
L E‘f ?'.
Los

e + Done [y

3 To add a photo to a contact card, which is then displayed

against messages, incoming calls and emails from that
contact, drag a picture onto the grey circle then crop and resize
it to your requirements. You can also click on this circle or the
Picture tab and navigate to a photo or default image or even
take a new one using the Camera option.
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Al on My Mac
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Al Google

Last import

To add details, click on the field and then type in the
iInformation. After entering a phone number or address,
another blank is offered, in case you want to add a second one.
Click on the name of the detail (in blue) for a pop-up window that
lets you change it. When you're finished, click Done. To change or
add information to a card you've completed, click Edit.

If you need a piece of information in a contact card that
doesn't currently have a blank field, open the Card
menu from the top bar and go to Add Field. You can then
choose one of the options on offer, such as: Maiden Name,
Nickname or Twitter name. This new field is then added to the
card, for you to fill in.




Edit = View Card Window Help

Enter Full Screen

Fred Adams

Tivra Tach

messago Phone

Powderham Vets - Newton A...

simon darcy abbott
James Abeler
Phone 07984 986890
Future Accounts FacaTime .
Fred Adams home fred.adams@icloud.com
e home 28 Fleeting Street

Haward Atchison Bradford

Yorkshire
Howard Aitchison BE13 BAK
Selene Alford

You can organise your contact cards into groups. To
show and hide the Lists panel, click on the View menu
and select Show/Hide Lists. To add a contact to a group,
simply drag it from the middle panel onto the group in
question. A card can be in more than one group at a time,
without being duplicated.

TivraTech

Kurt Andrews
Company

mobile

work v 0121555 32575
07946 96032

work ~ kandrews@tivratech.com

e A

home ~

7 To set up a card from a company rather than an

individual or display a contact according to the person’'s
employer instead of his or her name, check the box marked
Company at the top of the card. This reverses the name and
company details of the contact and indexes them according to
the company name.

Sharing Contacts

If you want to share a contact card with someone else, click the
icon showing a box with an up-pointing arrow and choose a
sharing option. You can send the contact as a v-card by
AirDrop, Mail, Messages and more. The person receiving it then
double-clicks the v-card to add it to their own address book.

Fred Adams
Twra Tech
—— oo =
bott massage iPhono mai
Phone 07984 986890
F FaceTime .
home fred.adams®@icloud.com
Iy home 28 Fleeting Street
Bradford
Yorkshire
1] BE11 3AK 1 @) Fred Adams
Contact Card
wte
&
o
J Fapercul on
Ga xy Willig
O Mail
in w4 Messages
#®  AirDrop
- MNotes
A} Parallels Access
£ Dropbox Transfer
& Freeform
in
&r Edit Extensions...

Facalime

work 0121555 32575
hema O7Q4R QRNA2

Smart List Name: | Xmas Cards| |

Contains cards that match the following condition:

does not contain
has not changed in
| has changed in

T Cancel
was updated after

v Mae 1
is member of
te is not member of

Smart Lists are groups with a set of rules. They
automatically include every card that satisfies the
parameters of chosen rules. Go to File > New Smart List to
open one. Here we're making a Smart List for every contact
that says 'Xmas card’ in the notes. Great for sending out
greetings cards at Christmas!

r b

going live in the facebook group for the next few weekends
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Open in Maps

0
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| kits Austin Eckman
:t with the Community... Join the Facebook Group :
Company
or need help?
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If you get an email, a message or other communication

with contact details in them, you can add them directly to
Contacts. Click on the details in question, and a pop-up window
lets you start a new Contacts card with those details already in
place. If you want to add the details to an existing card, click
Contacts and click on it in the new sidebar.

Using Contacts on iCloud

You can also access your contacts using a web browser on any
computer, tablet or smartphone that's connected to the Internet.
Just go to wwwi.icloud.com, enter your details and then click on
Contacts. Only cards stored under iCloud in your Contacts app
appear here, so bear this in mind when adding cards.

Scresnghot 2000-12-21 80 3475,

s Tams, 20222023

F Chaigtmass Cords List
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Calendar
Vi Plan Your Events

The Calendar app, as you'd expect, is there to help you organise your life.
With it you can add events, set reminders and synchronise your calendars
with your iPad or iIPhone. Birthdays and anniversaries can be stored and
you're able to set annually reoccurring events, as well as scheduled alerts.

Changing the View

pee O & 4
June 2024

e

weraraham Bariew's SId Birnglay o Jom Hobpnis's SEch Biniday

1 Luny Haliorshop's. Rirfhalay

@ 1T 1a
23 24 256

1 There are several different ways to view your calendars. The Year view shows you a complete year in a single

To move between Day, Week, Month and Year views, window. Clicking on the title bar for any month takes you to
you can use the corresponding buttons that appear in the its Month view. Double-click a specific day in either Year, Week or
top bar of the Calendar application. Month view to open its page in the Day view.

17 May 2024
Fricay

Thir Gravdsiand beeloamr Sewton Aol Facecourse, hewion Read, Mewan Abtot, England, United K

1 2 3 4
Mo Event Selectad

13 14 16 16 177 B B L+ I = N L O I 15 1€ 17 2 13 MM 1% 16 W
20 22 23 24 5 6 i7 18 19 20 N 2 I3 22 23 24 25 7 8 19 20 2 22 23 24 25
27 18 28 30 AN 24 25 26 27 28 2 20 23 3 3 4 26 27 26 29 0 N

MNovember

3 Click the Calendars button (top left) to open and close the Click the Today button in the top right corner to get to the
sidebar, as shown here. This sidebar is visible regardless Day, Week, Month or Year (depending on view) with the

of whether you're in Day, Week, Month or Year view and lets you current day in it. The arrows either side take you forward or back

mute or reveal individual calendars and more. one year, month, week or day at a time; depending on the display.
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Creating an Event

January 2024
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1 In Day and Week views, to add an event double-click

the time slot, then drag and/or expand/contract it into
place. The hours are divided into quarter-hour sections for
adding events. For all-day events, click the top bar.

January 2024
Wy X

# hiver Vieap @ J99h B
Pl e rebern

Double-click on an event to add and edit all sorts
of details in a pop-up window; including the title,
location, alerts, notes, URLs and more. The pull-down
menu in the top right of this window lets you change
which calendar it's stored in.

2 Clicking the '+ button in the toolbar lets you create a
quick event. Type in a title or brief description, day and or

time and Calendar intelligently enters it at the appropriate place.

For example, type ‘Dentist, 10th May, 11am’ and it's added.

Searching Calendar

January 2024
LAor

T Jwn

v e 8 Dy 1 Jainanty [Eoon e
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Ly Clumrs's S00% Barllwiddiy
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Make your events more easily searchable by labelling them
clearly and adding details in the notes section. The search
function scans both event names and notes for keywords, so the
more details you put in, the easier they are to find.

—y

(o

Tue Wed Thu Fri Sat Suf |

2 3 4 <] 6 7
- . THURSDAY, 30 AUGUST 2018

MONDAY, 28 NOVEMBER 2022

10 17 18 19 20 21
WEDNESDAY, 22 FEBRUARY 2023

25 26 27 o | | MOMOAY.3ARRN 2000

e Might (Scotia T Mark Brophy's Birt it Jamas Baaven's 53
T atanda Jane Sayvm
) Matihaw Ferce’s 5

Type any keywords into the search field to the right of the
top bar of the Calendar window. All results appear instantly
INn a pane at the bottom of the main window. The more keywords
you type in, the more unwanted results are filtered out.

Creating a Backup

You can manually create a complete backup of all the
calendars in your Calendars app. Open the File menu,
choose Export and select Calendar Archive. You can
rename the file and select a location to save it to. To load
it again, use the Import option.

File  Edit

View Window Help

New Event #¥N
New Calendar THEN
New Calendar Subscription... " &
New Holiday Calendar...

> Export..

Close SRV Calendar Archive... +
B T
February 2

Print... £ P
Mon

B Family
| Holidays in United Kingdom

baronnoise@gmail.com
th Gareth Lycett's Birt...

iCloud
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Calendar File Edit View Window Help

New Event 3E N
New Calendar N

New Calendar Subscription... &

New Holiday Calendar...

Import...

Export >
Close E'W B == ®

Print... J u n

Family
| Holidays in United Kingdom

/| baronnoise@gmail.com

Spring B3
1ICloud v

1 The flexible, versatile Calendar app lets you add as many

different calendars as you want and use them for different
things. To add a new calendar, open the File menu and select
New Calendar. A box appears, prompting you to enter a name
for your new calendar.

Mon Tue Wed
Spring Bank Holiday Sasha Metters
' Pam Bartlett
Personal
Bl
. 3 4 5

) Zhizhen Xiao's Birthday i+ Graham Barlow's 53rd Bi...

IR

) 10 1 12

) F Benedict Brain's Birthday Mum
1 Lucy Hattersley's Birthday (f Rahul Kabade's Birthday

M)
17 18 19

3 To select which calendars you want to appear active in the

main view, check or uncheck the boxes as appropriate. Each
calendar is colour-coded, as are their events. Unchecked calendars
aren't erased, you can check them again later if you wish.

Calendar Settings

@& Calendar File Edit View
About Calendar

Accounts...

Window Help

Add Account...
Services

Hide Calendar
Hide Others NHEH
Show All

+

Google

Jung

o4 Family

1

' Holidays in United Kingdom

+/ baronnoise@gmail.com

Spring Bai
iCloud

Personal
Gigs
® Odds & Ends

M To dn A

To open the Calendar Settings, use the Calendar menu as shown.
Under the General tab, you can change the way the app presents
itself, set when a day starts and ends, change the default calendar
and even switch to a Chinese, Hebrew or Islamic calendar.
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Adding and Viewing Additional Calendars

+

June 2024

\Y

| Holidays in United Kingdom

/| baronnoise@gmail.com

Spring Bank Holiday
iCloud

Personal

Gigs

To see acomplete list of all the calendars you've created in
the Calendars app, click the calendars button on the left side
of the top bar of the Calendar window, shown as a calendar icon. A
sidebar on the left of the window is revealed, showing all the
calendars you currently have set up.

5 6 Google

low's 53rd Bi... {fJem Roberts's 46th Birth... & Family
baronnoise@gmail.com

Estimate for New Kitchen . ® personal
Add Location or Video Cal @ Gigs

12 Odds & Ends

. - 12 Jun 2024 9am to 10am
dew Kitc... 9am [ ® Todo \g th
f -uf!-,j Alert, xepeat or iravel ime . DEEdIinE‘S
Add In _J Apple and Industry Dates
@ Holidays
e S @ Birthdays
19 20 21 )

To change the calendar under which an event s listed,
double-click the event to edit it then select a different calendar
from the drop-down menu. Alternatively, right or ctrl-click the event,
go to Calendar on the pop-up menu and select a new one.

Accounts

S} @ Q 25

General Accounts Alerts Advanced

Account Information Delegation

a iCloud

CalDAV Enable this account

»~ Google

CalDAV Description: iCloud

. Exchange Username: ian.osborne@dsl.pipex.com

i Exchange Refresh Calendars: Push

Under the Accounts tab, you can disable calendars you don't wish
to be active on the Mac in question, and also choose how each
calendar account refreshes. The Alerts tab lets you set default alert
settings, and under ‘Advanced’ you can make more customisations.



Sending Invitations

July 2024

Aor 15

T e w P gy ik

Double-click an event you created. In the pop-up window
that appears, click Add Invitees and begin typing the name
of a person in your Contacts whom you'd like to invite; or if the
personisn't in your contacts, enter their email address instead.

1

s Newton Hoad, Newton Abbol, TOQ12
3AF, England

18 Jul 2024 2 pm to 6pm
Alert when | nead Lo leave

@ James Gala
@ Mark Ayshford
(& Martin Smith
@ Alison Willis

2 pim -
Meeating with Jim, Ayshie,
Martin, Alison and Alyssa
Mewton Abbot Racecoursa
Newton Road, Mewlon 7
Abbat, TQ12 3AF, England © Nysea Fakon
@® s

Meeting 10 discuss the impending take-
over, and the trip to London to discuss it
with the shareholders,

* Finalisa brochures

= Arrange hotel

* Book train tickets

* Make list of attendeas

* Get laminates printed

* Review Keynote presentation

o o
I
|

When you've finished adding all the people you intend to
invite to your Calendar event, click on the Send button
and an invitation is sent to everyone on the list. You'll get
notifications of responses. You can cancel invitations or send
them to more of your contacts later if you wish.

g | pe | Ji ] e | or i |
' (L}

3 Your calendar entry shows who you've invited, and

the event is automatically added to their Calendar app and
updated whenever you make edits.

whether they've replied. If your invitee has an iCloud email,

Calendar | 17

iCloud Calendar

4 iCloud

More Apps Using iCloud

Hotes

ﬁ- Find My Mac

Open System Settings from the Apple menu in the top-left
corner of the screen. Click on Apple ID (top of the sidebar),
and under Apps Using iCloud, click the Show More Apps button.
Scroll to iCloud Calendar and make sure it's switched on.

% Photos

i (Cloud Drive

() iCloud Mad

£} Passwords and Keychain

Moles

[B Control Centre
Display & Brightness

n Home Screen & Multitasking

To activate iCloud syncing on an iPadOS or iOS device,
open Settings, tap your name at the top and then tap
iCloud. Make sure the Calendars switch is on. If it isn't, switch
it on to sync your calendars between the device in question
and all other Macs and 10S devices with syncing on.

July 2024

ﬂh_

3 Now, when you return to your Calendar app, all the
entries you made on your iOS devices are also shown

on your Mac and vice versa. It's a great way of keeping your

computer and your tablet or smartphone calendars in sync.
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